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1 Notes about this Documentation

Note
Keep this documentation!

The operating instructions are part of the product and shall be kept for the entire
lifetime of the device. They shall be transferred to each subsequent owner or user
of the device. Care must also be taken to ensure that any supplement to these
instructions are included, if applicable.

1.1 Validity of this Documentation

This documentation is only applicable to the telecontrol module 761-216
(TO-PASS® Compact, 8 Al, Web, MODBUS) and its variation 761-216/000-001.

1.2 Copyright

This Manual, including all figures and illustrations, is copyright-protected. Any
further use of this Manual by third parties that violate pertinent copyright
provisions is prohibited. Reproduction, translation, electronic and phototechnical
filing/archiving (e.g., photocopying) as well as any amendments require the
written consent of WAGO Kontakttechnik GmbH & Co. KG, Minden, Germany.
Non-observance will involve the right to assert damage claims.
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1.3 Symbols

i DANGER

Personal Injury!
Indicates a high-risk, imminently hazardous situation which, if not avoided, will
result in death or serious injury.

A DANGER

A Personal Injury Caused by Electric Current!
. Indicates a high-risk, imminently hazardous situation which, if not avoided, will

result in death or serious injury.

Personal Injury!
Indicates a moderate-risk, potentially hazardous situation which, if not avoided,
could result in death or serious injury.

A CAUTION

Personal Injury!
Indicates a low-risk, potentially hazardous situation which, if not avoided, may
result in minor or moderate injury.

NOTICE

Damage to Property!
Indicates a potentially hazardous situation which, if not avoided, may result in
damage to property.

NOTICE

A Damage to Property Caused by Electrostatic Discharge (ESD)!
Indicates a potentially hazardous situation which, if not avoided, may result in

damage to property.

Note

Important Note!
Indicates a potential malfunction which, if not avoided, however, will not result in
damage to property.

|
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Information

“ Additional Information:

Refers to additional information which is not an integral part of this
documentation (e.g., the Internet).
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1.4

1.5

Number Notation

Table 1: Number notation

Number code Example Note
Decimal 100 Normal notation
Hexadecimal 0x64 C notation
Binary '100° In quotation marks, nibble separated with
'0110.0100' dots (.)
Font Conventions
Table 2: Font conventions
Font type |Indicates
italic Names of paths and data files are marked in italic-type.
e.g.. C:\Programme\WAGO-1/0-CHECK
Menu Menu items are marked in bold letters.
e.g.: Save
> A greater-than sign between two names means the selection of a
menu item from a menu.
e.g.: File > New
Input Designation of input or optional fields are marked in bold letters,
e.g.: Start of measurement range
“Value” Input or selective values are marked in inverted commas.
e.g.: Enter the value “4 mA” under Start of measurement range.
[Button]  [Pushbuttons in dialog boxes are marked with bold letters in square
brackets.
e.g.: [Input]
[Key] Keys are marked with bold letters in square brackets.
e.g.: [F5]

waco'
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2

2.1

211

2.1.2

2.1.3

2.1.4

Important Notes

This section includes an overall summary of the most important safety
requirements and notes that are mentioned in each individual section. To protect
your health and prevent damage to devices as well, it is imperative to read and
carefully follow the safety guidelines.

Legal Bases

Subject to Changes

WAGO Kontakttechnik GmbH & Co. KG reserves the right to provide for any
alterations or modifications that serve to increase the efficiency of technical
progress. WAGO Kontakttechnik GmbH & Co. KG owns all rights arising from
the granting of patents or from the legal protection of utility patents. Third-party
products are always mentioned without any reference to patent rights. Thus, the
existence of such rights cannot be excluded.

Personnel Qualification

All sequences implemented on Series 761 devices may only be carried out by
electrical specialists with sufficient knowledge in automation. The specialists
must be familiar with the current norms and guidelines for the devices and
automated environments.

All changes to the controller should always be carried out by qualified personnel
with sufficient skills in PLC programming.

Use of the TO-PASS® Telecontrol Modules in Compliance
with Underlying Provisions

The TO-PASS® telecontrol modules receive digital and analog signals from
sensors and transmit and output them to higher-ranking controllers. Additionally,
it is possible to (pre-)process them.

The devices have been developed for use in an environment that meets the 1P20
protection class criteria. Protection against finger injury and solid impurities up to
12.5 mm diameter is assured; protection against water damage is not ensured.
Unless otherwise specified, operation of the device in wet and dusty environments
is prohibited.

Technical Condition of Specified Devices

The components to be supplied Ex Works, are equipped with hardware and
software configurations, which meet the individual application requirements.
WAGO Kontakttechnik GmbH & Co. KG will be exempted from any liability in
case of changes in hardware or software as well as to non-compliant usage of
components.
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2.2

2.3
231

2.4

Please send your request for modified and new hardware or software
configurations directly to WAGO Kontakttechnik GmbH & Co. KG.

Disclaimer

TO-PASS® telecontrol modules communicate using the GSM network (Global
System for Mobile Communication). Exemptions cannot be made for GSM
services used by the TO-PASS® telecontrol modules as they may be exposed to
faults in the service provider’s network. WAGO Kontakttechnik GmbH & Co.
KG has no involvment with these types of problems.

Therefore, WAGO Kontakttechnik GmbH & Co. KG will reject any guarantee for
the implementation of commands transmitted from and received by the TO-PASS®
telecontrol module.

Firmware Licensing Terms

Firmware with Open Source GPL

The TO-PASS® Compact telecontrol module firmware contains Open Source
software under GPL. According to Section 3b of GPL, we offer you the source
code.

You can obtain the source code with licensing terms of the Open Source software
from WAGO Kontakttechnik GmbH & Co. KG on request. Send your request to
support@wago.com with the subject "Open Source TO-PASS Compact".

Block Rounding for GPRS Connections

The connection to the provider is established separately for each GPRS data
transfer up to Firmware Version 2.31 (approx. 1 ... 2 kBytes). As a result, at least
one block rounding per data transfer is billed.

Starting from Firmware Version 2.31, a permanent GPRS connection is
established to the provider. Therefore, data transfers made within the billing
period (e.g., one day) are summated for block rounding. In the event of continuing
disturbances in the data transfer, the TO-PASS® telecontrol module will briefly
interrupt the permanent GPRS connection, which also effects block rounding.

waco'
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2.5 Safety Advice (Precautions)

For installing and operating purposes of the relevant device to your system the
following safety precautions shall be observed:

i DANGER

A Do not work on components while energized!
All power sources to the device shall be switched off prior to performing any

installation, repair or maintenance work.

» DANGER

Installation only in appropriate housings, cabinets or in electrical operation
rooms!

TO-PASS® telecontrol modules are exposed operating equipment. They may only
be assembled in housings, cabinets or in electrical operation rooms. Access is
only permitted via a key or tool to authorized qualified personnel.

A DANGER

A Use SELV/PELYV power source only!
The TO-PASS® telecontrol module must only be powered from a PELV
(Protective Extra Low Voltage) or SELV (Safety Extra Low Voltage) power

source complying with the limited power source (LPS) requirements per DIN EN
60950-1.
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Please note the following information about FCC Part 15!

FCC Part 15.19

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following conditions:

1. this device may not cause harmful interference, and

2. this device must accept any interference received, including interference that
may cause undesired operation.

FCC Part 15.21
Modifications not expressly approved by this company could void the user's
authority to operate the equipment..

Installation b%/ qualified electrician only

The TO-PASS™ telecontrol module must be operated with Antenna 758-0963.

The antenna gain main not exceed 3 dBi.

Only qualified staff can install and maintain the TO-PASS® remote module and its
antenna. The transmitted must be off when working on or nearer to the antenna
than specified below.

HF-Exposition

The external antenna operated with the TO-PASS® remote module must be at least
20 cm away from people. The antenna may not be positioned, so that it works in
conjunction with any other antenna or transmitter.

A CAUTION

Hot surface!
The surface of the housing can become hot during operation. If the device was
operated at high ambient temperatures, allow it to cool off before touching it.

NOTICE

Do not reverse the polarity of connection lines!
Avoid reverse polarity of data and power supply lines, as this may damage the
devices involved.

NOTICE

Replace defective or damaged devices!

Replace defective or damaged device/module (e.g., in the event of deformed
contacts), since the long-term functionality of device/module involved can no
longer be ensured.

waco'
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i

NOTICE

Protect the components against materials having seeping and insulating
properties!

The components are not resistant to materials having seeping and insulating
properties such as: aerosols, silicones and triglycerides (found in some hand
creams). If you cannot exclude that such materials will appear in the component
environment, then install the components in an enclosure being resistant to the
above-mentioned materials. Clean tools and materials are imperative for handling
devices/modules.

NOTICE

Cleaning only with permitted materials!
Clean soiled contacts using oil-free compressed air or with ethyl alcohol and
leather cloths.

NOTICE

Do not use any contact spray!
Do not use any contact spray. The spray may impair contact area functionality in
connection with contamination.

NOTICE

Avoid electrostatic discharge!

The devices are equipped with electronic components that you may destroy by
electrostatic discharge when you touch. Pay attention while handling the devices
to good grounding of the environment (persons, job and packing).

Manual
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3

3.1

3.2

Device Description

Scope of Delivery

The scope of delivery of the TO-PASS® telecontrol module, without options,
includes only the TO-PASS® telecontrol module. Suitable antennas are available
as accessories.

Note
SIM Card

Please note that one SIM card is required to operate each TO-PASS® telecontrol
module and may be obtained from typical service providers such as T-Mobile,
VODAFONE or EPlus. WAGO Kontakttechnik GmbH & Co. K.G. is prepared to
assist with the selection of the most cost-effective tariff for your application.

Use

The TO-PASS® product family is designed for wireless communication of signals
and messages. This includes:

. compact module for the connection of signals from plants,
. transmission,
. preparation of values for the operator.

TO-PASS® telecontrol modules 761-216 may be used as:

. fault indicator,

. remote data request system,
. data memory,

. event logger,

. permanent on-line link,

. telecontrol modules.

The system is connected in wireless mode to PCs, hand computers, Internet PCs,
web servers, mobile telephones, fax, e-mail receivers or land-line telephones.
Influences to the system are also possible.

Communication occurs using the global mobile radio network “GSM” (Global
System for Mobile Communication). A SIM card is required for the TO-PASS®
telecontrol module to use this network. As in the case of a mobile telephone, the
TO-PASS® telecontrol module requires the SIM card in order to be able to “log
on” to the network.

When generating a new configuration file, you can select the scope of functions
based on the available firmware versions, or on the required functionalities.
Differences between these are shown in the following table.

waco'
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Table 3: Overview of functions

Functionality

FW 2.20

FW 2.31

FW 2.32

FW 2.33

Module name length
(Identity)

8 characters*)

16 characters*)

16 characters®)

16 characters®)

“Prepaid” request Always active Can be de- Can be de- Can be de-
activated activated activated

Address length 40 characters*) |60 characters*) |60 characters*) |60 characters*)

Data transmission to the | Standard script | SV=01.01 Sv=01.01 SVv=2.00

value script

Data transmission to the | Standard script | LV=2.00 LV=2.00 LVv=2.01

logger script

Address(es) for SMS First address Selectable Selectable Selectable

interval

Configuring GPS Not possible Possible with Possible with Possible with

settings mobile devices | mobile devices | mobile devices

"Prepaid" request text |, *100#" ,»*100# 1004 Parameterizable

Number check 7 characters*) 7 characters*) 7 characters*) 0..20
characters*)

Script version Standard Extended Extended Parameterizable

Time request script Not Not Not Implemented
implemented implemented implemented

Counter inputs Not supported Not supported Not supported Supported

Delay time Not supported Not supported Not supported Supported

Turn-off time Supportedtoa |Supportedtoa |Supportedtoa |Extended
limited extent: limited extent: limited extent:

Resolution of analog Without decimal | Without decimal | Without decimal | With decimal

outputs places places places places

Switched Web interval | Not possible Not possible Can be used Can be used

Setpoint setting via Not possible Not possible Not possible Can be used

Web check-back

Limited SMS Not possible Not possible Not possible Can be used

transmission

Acknowledgement text |"ACK" "ACK" "ACK" Parameterizable

MODBUS format

Supported to a
limited extent:

Supported to a
limited extent:

Supported to a
limited extent:

Extended

No other components are required, other than the SIM card to connect to the GSM
mobile radio network and a GSM antenna (available as an accessory). Modems
and interfaces are already installed in the TO-PASS® telecontrol module.

Version 2.0.0
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3.3 View
1 2 3
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Figure 1: Front view
Position | Description
1 SIM Card insert
2 Antenna connection
3 Statusindication
4 PC interface
5 Connecting terminals for the supply, inputs and outputs
® Manual
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3.4 Connectors

34.1 Antenna

The screw connector (SMA socket) for the GSM antenna is located at the top of
the housing.

Figure 2: Antenna connection

Note
Observe the maximum length of the antenna cable!

The total length of the antenna cable shall not exceed 30m! The reception quality
decreases with increasing antenna cable length!
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3.4.2 Operating Voltage

A DANGER

Use SELV/PELV power source only!
The TO-PASS® telecontrol module must only be powered from a PELV
(Protective Extra Low Voltage) or SELV (Safety Extra Low Voltage) power

source complying with the limited power source (LPS) requirements per DIN EN
60950-1.

Table 4: Terminal assignment for operating voltage

SE=R=E=R=R=N=R=)=

olicoM
olicoM
e=llilf@allll
@slliifestiil
on)llifen)ill

SEEEE
06000808080
SEEEBEEES
06060608880

OoOle

00000
SEEEEE
00000

Uv

2
Uv

4
GND

Shield

Figure 3: Terminal assignment for operating voltage

Connection |Short name Designation

1,2 Uv Operating voltage (+) DC +10 ... 30 V
3,4 GND Operating voltage (-) DC 0 V, Ground

38 Shield Enclosure screening, connection of the PE

- Note

Connect the shield connection to the DIN rail!

: The shield connection of the TO-PASS® telecontrol module (shield, terminal 38)
must be connected to the DIN rail. The DIN rail must have a low-impedance
ground (see section "Connections" > "Ground").
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3.4.3

3431

I\

3.4.3.2

3.4.3.3

Grounding
Framework Assembly

When setting up the framework, the carrier rail must be screwed together with the
electrically conducting cabinet or housing frame. The framework or the housing
must be grounded. The electronic connection is established via the screw. Thus,
the carrier rail is grounded.

Ensure sufficient grounding is provided!
You must take care to ensure the flawless electrical connection between the
carrier rail and the frame or housing in order to guarantee sufficient grounding.

Insulated Assembly

Insulated assembly has been achieved when there is constructively no direct
conduction connection between the cabinet frame or machine parts and the carrier
rail. Here the earth ground must be set up via an electrical conductor accordingly
valid national safety regulations.

Note

Recommendation
The optimal setup is a metallic mounting plate with grounding connection with an
electrical conductive link with the carrier rail.

The separate grounding of the carrier rail can be easily set up with the aid of the
WAGO ground wire terminals.

Table 5: WAGO ground wire terminals

Item No. |Description

283-609 |1-conductor ground (earth) terminal block make an automatic contact
to the carrier rail; conductor cross section: 0.2 -16 mm?
Note: Also order the end and intermediate plate (283-320).

Grounding of the TO-PASS® Telecontrol Module

The shield connection of the TO-PASS® telecontrol module (shield, terminal 38)
must be connected to the grounded DIN rail.
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3.4.4

3441

3.44.2

3.44.3

Shielding
General

Shielding of the data and signal lines reduces electromagnetic interference, thus
enhancing signal quality. Measurement errors, data transmission errors, and even
destruction due to excessive voltage can be prevented this way.

Note

Connect the cable shield to the ground potential!

Integrated shielding is mandatory to meet the technical specifications in regards to
measuring accuracy. Connect the cable shield and ground potential at the inlet to
the cabinet or housing. This allows induced interference to dissipate and to be
kept away from devices in the cabinet or housing.

Note

Improve shielding performance by placing the shield over a large area!

Higher shielding performance is achieved via low-impedance connection between
shield and ground. To achieve this, connect the shield over a large surface area,
e.g., WAGO shield connecting system. This is especially recommended for large-
scale systems where equalizing current or high impulse-type currents caused by
atmospheric discharge may occur.

Note

Keep data and signal lines away from sources of interference!

Route data and signal lines separately from all high voltage cables and other
sources of high electromagnetic emissions (e.g., frequency converter or drives).

Bus Lines

The shielding of bus lines is described in the respective configuration guidelines
and standards for the bus system.

Signal Lines

Note

Use shielded signal lines!

Use only shielded signal lines for serial and analog signals. Only then can you
ensure that the accuracy and interference immunity specified for the respective
I/0 module can be achieved, even in the presence of interference acting on the
signal cable.

Signal lines for analog signals must be shielded. The shield for the signal lines
must be connected to Terminal 38 (Shield) of the TO-PASS® telecontrol module,
e.g., via the DIN rail.

waco'
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3.44.4

WAGO Shield Connecting System

The WAGO shield connecting system consists of shield clamping saddles,
busbars and various mounting carriers to enable a wide variety of setups. For
more information on this, refer to the "Accessories” section of the main catalog.

Figure 4: Example of the WAGO shield connecting system
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3.4.5 Digital Inputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Table 6: Terminal assignment for digital inputs

HEEEBEHEHEBEHE

@n)llif@slill
ol
e=lllif@alill
e=llllf@slill
@n)llif@nlill
o

00
=J=
80

ull o=llilf e
~ ol

SEEB8E
6060008000
SEEEBEEEEE
60606088000

1
DI1 | DI3 | DI5 | DI7
6|8|10/12

DI2 | DI4 | DI6 | DI8

Figure 5: Terminal assignment for digital inputs

Connection |Short name Designation

5 DIl Digital input 1
6 DI2 Digital input 2
7 DI3 Digital input 3
8 D14 Digital input 4
9 DI5 Digital input 5
10 DI16 Digital input 6
11 DI7 Digital input 7
12 DI8 Digital input 8

Digital inputs DI1 ... DI4 can also be configured alternatively as counter inputs,
starting from Firmware Version FW 2.33. For more information about
configuring, refer to the Section "Configuring™ > "Counter Inputs".
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3.4.6

Counter Inputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Digital inputs D1 ... D4 can be configured as counter inputs.

Table 7: Counter input pin assignments

HEEEBEHEHEBH

EEEBEBEE
00600808006000880008
EEEEEEEEEBEEEEE
00800600088000088

O
=
O

Figure 6: Counter input pin assignments

Connection |Short name Explanation

5 DIl Counter input 1 (configurable)
6 DI2 Counter input 2 (configurable)
7 DI3 Counter input 3 (configurable)
8 Dl4 Counter input 4 (configurable)
38 Shield Shield termination

Note

Connect shielding!

Shielded cables are recommended for the counter inputs.
When using shielded cables, the shield must be routed to the grounded DIN rail
(see Section "Connections" > "Shielding").
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3.4.7 Analog Inputs

A DANGER

A Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Table 8: Terminal assignment for analog inputs
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+
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> 3o OO

Al2

Al3

1812022 |24 |26

Al4 | AI5 | Al6 | Al7

28

Figure 7: Terminal assignment for analog inputs

Connection |Short name Designation

13 All+ Analog input 1 (+)
14 All- Analog input 1 (-)
15 Al2+ Analog input 2 (+)
16 Al2- Analog input 2 (-)
17 Al3+ Analog input 3 (+)
18 Al3- Analog input 3 (-)
19 Al4+ Analog input 4 (+)
20 Al4- Analog input 4 (-)
21 Al5+ Analog input 5 (+)
22 Al5- Analog input 5 (-)
23 Al6+ Analog input 6 (+)
24 Al6- Analog input 6 (-)
25 Al7+ Analog input 7 (+)
26 Al7- Analog input 7 (-)
27 AlB8+ Analog input 8 (+)
28 Al8- Analog input 8 (-)
38 Shield Enclosure screening

waco'
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Note
Analog inputs are single-ended!

The analog inputs are single-ended and the “Aix=" connections are connected
internally to the “GND” connections.

Note
Connect shielding!

Shielded cables are required for analog inputs. The cable shield must be
connected to the grounded DIN rail (see section "Connections™ > "Shielding").
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3.4.8

Digital Outputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Table 9: Terminal assignment for digital outputs

EEEBEEBEEBEEEBEH

0000
===
8000

O

O

00
==
80

Figure 8: Terminal assignment for digital outputs

Connection |Short name Designation

33 DO1 Digital output 1

34 DO2 Digital output 2

35 DO3 Digital output 3

36 DO4 Digital output 4

37 DO Vce (+) Voltage for the digital outputs
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3.4.9 Analog Outputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Table 10: Terminal assignment for analog outputs

HEEEEEBEEBEHEHEH

SEEE8E
000060600080880800
SEEEEEE8EEEE8E8E
00006060808808880800

Figure 9: Terminal assignment for analog outputs

Connection |Short name Designation

29 AO1+ Analog output 1 (+)
30 AO1- Analog output 1 (-)
31 AO2+ Analog output 2 (+)
32 AO2- Analog output 2 (-)
38 Shield Enclosure screening

— Note
Connect shielding!

Shielded cables are required for analog outputs. The cable shield must be
connected to the grounded DIN rail (see section "Connections™ > "Shielding").
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3.4.10 Serial Interface to the PC and MODBUS Interface

Table 11: Serial interface to the PC and MODBUS interface

R Pin Description
@ @ 1 Not assigned
2 TXD
987 6
3 RXD
4 Not assigned
5 GND
6 Not assigned
PC 7 MODBUS RX
Figure 10: Serial interface to the PC 8 MODBUS TX
and MODBUS interface -
9 Not assigned
Table 12: PC interface cable assignment
TO-PASS®
Telecontrol Module Fo=atlag)
Pin | Description Pin | Description
2 TXD > 2 RXD
3 RXD < 3 TXD
5 GND 5 GND

Note

Connecting laptops and PCs without serial interface:
If the laptop or PC does not have a serial interface, use the USB adapter 761-

9005, which is available as an accessory.

Table 13: MODBUS cable assignment

TO-PASS®
Telecontrol Module uloDEs st
Pin | Description Pin | Description
5 GND MODBUS GND
7 MODBUS RX < MODBUS TX
8 MODBUS TX > MODBUS RX
W ® . Manual
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3.5

Display Elements

Table 14: Display Elements

OCom
OBusy
ORun

Status

Figure 11: Display
Elements

Com Busy Run

Description

Green
0.5Hz
blinking

X X

Ready to operate

Green X X

Communication via RS232
interface

Green
1Hz X X
blinking

Firmware update

X Green X

GSM modem is activated

- Initialization (takes
approx. 40 s after system
start-up if everything is
OK)

- SMS/GPRS processing

- Antenna is not connected
(the modem is searching
for a network)

- Poor GSM network (the
modem is searching for a
network)

Green
X 1Hz X
blinking

Error in communication with
SIM card

- No SIM card available

- SIM card is defective

Green
X 5Hz X
blinking

Serious error in

communication with GSM

modem

- PIN of SIM card in TO-
PASS® parameterization
is deactivated, but not on
SIM card

- Incorrect PIN set on TO-
PASS®

- SIM card locked

X: Any state (ON or OFF)
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3.6 Technical Data
3.6.1 Housing
Table 15: Technical Data Housing
Dimensions (W x H x L) 109 mm x 105 mm x 78 mm
Weight Approx. 412 g
Operating temperature -20°C ... +70 °C
Storage temperature -40 °C ... +85°C
Type of mounting DIN 35 rail
Degree of protection IP 20
Wire connection Terminal strips (WAGO 250 Series)
with push-wire connection
Cross section 0,5mm2 ... 1,0 mm?
AWG 22 ... AWG 14 ,sol*
Stripped length 9mm ... 10 mm
3.6.2 Supply
Table 16: Technical Data Supply
Operating voltage +10V ... +30 VDC
Nominal voltage, operation with mains |+24 VDC
power
Nominal voltage, operation using +12 VDC
battery
Bias current approx. 20 mA
(with +24 VVDC power supply, without
external protective circuit)
Current for transmission <500 mA
(with +24 VVDC power supply)
3.6.3 GSM Antenna Connection

Table 17: Technical Data GSM Antenna Connection

Connection SMA socket

Cable length (max.) 30 m

Bandwidth 70 MHz in GSM (850 MHz)
80 MHz in EGSM (900 MHz)
170 MHz in DCS (1800 MHz)
140 MHz in PCS (1900 MHz)

Gain < 3 dBi

Impedance 50 Ohm

Input power > 2 W (peak power)

VSWR (max.) <=10:1

VSWR (recommended) <=2:1

waco'
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3.6.4 GSM Communication
Table 18: Technical Data Communication
Number of recipients 4
Recipient types PC, SMS, e-mail, phone, fax
Communication GSM quad-band
Communication types SMS (bidirectional),
telecommunication dial-up connection
(CSD),
GPRS connection to Internet
3.6.5 MODBUS Communication
Table 19: Technical Data MODBUS Communication
MODBUS interface RS-232
MODBUS Protocol RTU
MODBUS register query Input; Holding
Interface speed 9600 Baud / 19200 Baud
Interface parameters 8N2/8E1/801/8N1
3.6.6 Digital Inputs
Table 20: Technical Data Digital Inputs
Number of inputs 8
Input type Type 3 acc. to IEC 61131-2
Input voltage OV..30vDC
Signal voltage ,,0“ OV..5VDC
Signal voltage ,,1“ 7V ...30vDC
Input current ya (at 30 V DC) 2.9 mA
3.6.7 Counter Inputs
Table 21: Technical Data Counter Inputs
No. of counters Max. 4, configurable
Counter frequency Max. 2000 Hz
Resolution 32 bits
Count direction Up/Down
Manual
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3.6.8  Analog Inputs

Table 22: Technical Data Analog Inputs

Number of inputs 8

Input current 0/4 mA ... 20 mA

Internal resistance Approx.. 200 Q / 20 mA
Resolution 12 bit

Measuring error (25°C) < +1 % of the full scale value
Temperature coefficient < 0.1 % / K of the full scale value

3.6.9 Digital Outputs

Table 23: Technical Data Digital Outputs

Number of outputs 4

Output type Semiconductor outputs

Output current 0.5 A/30 V DC, short-circuit protected
Type of load Resistive, inductive, lamps

Energy dissipation Wmax. 125 mJ;

(unique switching off) Linax = 2 * Winax / I?

3.6.10 Analog Outputs

Table 24: Technical Data Analog Outputs

Number of outputs 2

Output current 0/4 mA ... 20 mA

Load impedance <600 Q

Resolution 12 bit

Measuring error (25°C) < x1 % of the full scale value
Temperature coefficient < 0.1 % / K of the full scale value

3.6.11 Data and Event Logger

Table 25: Technical Data Data and event logger

Memory type Ring memory
Memory size Without configured |4096 process images
counters
With configured 2048 process images
counters
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3.7 Approvals

The following approvals have been granted for the telecontrol module 761-216and
all versions thereof:

C€ cConformity Marking

cus cULuys UL508

R&TTE Complaint with 1999/5/EG directive (per Article 3.2)
RoHS  Device complies with European RoHS directive.

FCC  Verification per FCC 15b

The following approvals have been granted for the standard version of the
telecontrol module 761-216:

Approval, Canada

Approval, Croatia

Approval, Mexico

Approval, Turkey

The following approvals have beeen granted for versions 761-216/000-001.:

PCS Type Certification Review Board,
with Software Index 01 (FW 02.30.14) and Hardware Index 01

Approval, USA

PTCRB

3.8 Standards and Guidelines

761-216 telecontrol modules meet the following requirements on emission and
immunity of interference:

EMC CE-Immunity to interference acc. to EN 61000-6-2: 2005
and acc. to EN 61131-2: 2007
EMC CE-Emission of interference acc. to EN 61000-6-3: 2007

and acc. to EN 61131-2: 2007
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4

4.1

Mounting

Note

IP20 degree of protection

The protection class of the TO-PASS® telecontrol module is IP 20. For this reason,
WAGO Kontakttechnik GmbH & Co. KG recommends mounting in a housing or
in a switching cabinet.

Note

Ambient temperature -20 °C to +70 °C

The TO-PASS® telecontrol module is designed for an ambient temperature of -20
°Cto +70 °C.

In the event of higher or lower temperatures, proper cooling or heating
arrangements must be provided.

Please contact WAGO Kontakttechnik GmbH & Co. K.G. for assistance.

The TO-PASS® telecontrol module is designed to mount on a DIN 35 carrier rail.

Mounting the TO-PASS® telecontrol module to the
DIN rail

\1'1.

Figure 12: Mounting the TO-PASS® telecontrol module to the DIN rail
1. Place the TO-PASS® telecontrol module on the DIN rail from above.

2. Press the undersurface against the lower DIN rail edge until the TO-PASS®
telecontrol module locks into place.

waco'
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42  Removing the TO-PASS® telecontrol module from

the DIN rall
2.
—_ >
® ®
s
®
1

T4

Figure 13: Removing the TO-PASS® telecontrol module from the DIN rail

1.  Press the undersurface against the lower DIN rail edge until the TO-PASS®
telecontrol module is no longer locked in place.

2. Remove the TO-PASS® telecontrol module from the DIN rail.
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5

5.1

Connect Devices

Connecting the Push-wire Connections to the
Conductor

The push-wire connections of the TO-PASS® telecontrol modules are designed for
solid or fine-stranded conductors with cross sections between 0.5 ... 1.5 mm?
(AWG 22 ... 14 ,s01%).

Note

Connect only one conductor per clamp!
Only connect one conductor to each push-wire connection. Do not connect more
than one conductor at one single connection!

If more than one conductor must be routed to one connection, these must be
connected in an up-circuit wiring assembly, for example using WAGO feed-
through terminals.

Terminate both solid and ferruled conductors without actuation by simply pushing
them in. For all other conductor types, a suitable operating tool must be used to
open the push-wire connection for connection.

Note

Observe strip length!

When using short ferrules, the retention force of the push-wire connection may be
reduced. Strip length from 9 to 10 mm must be observed for a safe push-wire
connection.

1.  To open the push-wire connection, use the tool to press the button above the
connection.

2. Insert the conductor into the corresponding connection opening.

3. To close the push-wire connection, release the button. The conductor is
clamped.

waco'
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5.2 Connection Examples

Note

Connect the shield connection to the DIN rail!

: The shield connection of the TO-PASS® telecontrol module (shield, terminal 38)
must be connected to the DIN rail. The DIN rail must have a low-impedance
ground (see section "Connections™ > "Ground").

5.2.1 Digital Inputs

s DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

5/719 1
DI | DI3 | DI5 | DI7

Figure 14: Connection example for switch at input DI1
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5.2.2 Counter Inputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

_— Note
Connect shielding!

Shielded cables are recommended for the counter inputs.
When using shielded cables, the shield must be routed to the grounded DIN rail
(see Section "Connections™ > "Shielding").

g y

Figure 15: Connecting example, switching contact at counter input DI1
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5.2.3 Analog Inputs

A DANGER

A Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

Note

9 Analog inputs are single-ended!
The analog inputs are single-ended and the “Aix—" connections are connected
internally to the “GND” connections.

Note

Connect shielding!
Shielded cables are required for analog inputs. The cable shield must be
connected to the grounded DIN rail (see section "Connections™ > "Shielding").

M

523.1 Current Measurement

13,15

Al1 | Al2
+ | +

1416
All | AI2

Figure 16: Connection example of transducer with current output at input All
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5.2.3.2 Voltage Measurement

Note

Voltage measurement can only be performed via U/l transformer!

' Voltage measurement cannot be performed via multiplier at the analog inputs,
since the internal resistance of the TO-PASS® telecontrol module depends on the
input current.

WAGO 857 Series JUMPFLEX Isolation Amplifiers for level conversion may be
used for voltage measurement via TO-PASS® telecontrol modules.

13|15|17 19 21
A1 | A2 | AI3 | Al4 | AI5

14116182022
A1 | A2 | AI3 | Al4 | AI5

+°—
Al Uy
-O—

Figure 17: Connection example for voltage measurement via U/l converter at input All
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5.2.4  Digital Outputs

A DANGER

\ Only connect SELV/PELYV voltages!
A Only SELV/PELYV voltages shall be connected to the device terminals.

Figure 18: Connection example for a relay at DO1 output
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5.2.5  Analog Outputs

A DANGER

Only connect SELV/PELYV voltages!
Only SELV/PELYV voltages shall be connected to the device terminals.

_— Note
Connect shielding!

Shielded cables are required for analog outputs. The cable shield must be
connected to the grounded DIN rail (see section "Connections™ > "Shielding").

5.25.1 Current Measurement

/1\ AO1 -

Figure 19: Connection example for a display device at AO1 output
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5.25.2 Voltage Measurement

R.: Load resistance, Ry: Internal resistance of measuring device

RL || Rmmust be less than 600 Q.

With Ry >> R the impact of Ry, can be neglected.
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526 MODBUS Interface

5.26.1 Serial Interface for MODBUS and PC

5 4132 1
Dsub min LR
female @ 0 0 O
9 8 7 6
112 (3 415 to
Dsub min coo0o PC
male 0O 00O
6 [7 8 9
to
WAGO TO-PASS ilals als
Telecontrol Module
Dsub min 00000
male 0O 00O
6 7 8 9
to
Modbus Slave

Figure 20: Connection example for serial interface for MODBUS and PC
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5.2.6.2 MODBUS RS-485 Network

WAGO TO-PASS
(Master) 5 4 8 2 1

RS-485 T+T- R+ R-Gnd

-]
i
0

Y B U S FHNRY 0 1 S
: Modbus ;
T+T- R+ R-Gnd T+T- R+ RGnd
Device n TR Device m
(Slave) (Slave)

Figure 21: Connection example for MODBUS RS-485 Network (Fullduplex)
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6 Commissioning

6.1 Installing the Operating Software

1.

Place the CD with the TO-PASS® operating software in the CD drive of the
PC.

The "Autostart” function is normally activated on set-up.
If the set-up program does not start automatically, perform steps 2 to 6.

Close all applications so that the desktop is displayed by the operating
system.

Move the mouse pointer over the [Start] button of the Windows operating
system and click the right mouse button.

Select Windows “Explorer” using a double click

Select the CD drive in which you have placed the CD with the operating
software.

Start the "WAGO TO-PASS_SETUP(2.17).EXE" program, or a newer
version in the main directory on the CD.

Follow the menu prompting to choose a default installation path.
Starting with Version 2.17 of the operating software, the module files and
exported, logged information are stored in a central directory:

Windows XP
Documents and settings\All Users\(Common )Documents\
WAGO Software\WAGO TO-PASS

Windows 7:
User\Public\Public documents\WAGO Software\
WAGO TO-PASS

You can save an update file in the "update” subdirectory that can then be
used for a firmware update.

Installation has been completed successfully when the message "Software
has been installed successfully™ appears.
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6.2 Starting the TO-PASS® Telecontrol Module

Note
Do not switch on yet!

Do not switch on the TO-PASS® telecontrol module until you are prompted to do
s0; do not insert the SIM card for this procedure.

Note
Deactivate the PIN!

During commissioning, the SIM card may be disabled when an incorrect or
incomplete PIN is entered. It is therefore recommended that you disable the PIN
of the SIM card to be inserted. To do this, insert the SIM card in a mobile
telephone and select the menu option Security > Disable PIN.

Note
Deactivate the call diversion

Deactivate all call diversions of the SIM card to be inserted to achieve a trouble-
free availability of the TO-PASS® telecontrol module.

Before using the TO-PASS® telecontrol module it must first be configured with
the telephone number.

1. Every TO-PASS® telecontrol module requires an SIM card for proper
operation. You can obtain an SIM card from any mobile telephone service
provider. Special data cards are recommended.

2. Every SIM card contains a telephone number and a PIN code for enabling
the SIM card to be used in the TO-PASS® telecontrol module.

Always have this telephone number and PIN code on hand.

3. Connect the PC to the installed TO-PASS® telecontrol module via the serial
interface.

4..  If the PC has only USB interfaces, a USB — RS-232 adapter is required.
Install the driver supplied with the adapter according to the adapter
manufacturer's specifications.

A USB adapter is available as an accessory 761-9005.

5.  Start up the PC and then the TO-PASS® operating software.
6.  Select the menu item File > Settings.

7.Set this as a "RS-232" connection and select the appropriate interface, e.g.
"COM1".

8. Then select menu item File > New module.
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10.

11.

12.

13.

14.
15.

16.

17.

18.

When generating a new configuration file, select the firmware version for
the device that implements the required functionality as the first version in
the Function selection field.

The device versions, along with the associated enabling firmware indices
are displayed to make selection easier.

In the field Module name enter an identifier for the new device (maximum
8 places for FW version 2.20, or 16 places for all other firmware versions).
This identity is the name of your TO-PASS® telecontrol module and serves
as an identifier. It can only be changed at a later time by completely
overwriting it. The identifier is also transmitted as an SMS, fax or e-mail in
the event of an error and should therefore be a typical identifier that is easy
to associate with the location of use, such as "Tank 1".

A new module will be created at the top left of the screen in the project tree.
Click on "+" to reveal the rest of the tree. Select the entry "ldentity" and
enter the phone number for the SIM card in the Phone number field at the
right. In the following line, deactivate the [Use PIN] button, so that the TO-
PASS® telecontrol module does not use the PIN code. Also deactivate the
PIN on the SIM card! To do this, insert the SIM card into a cell phone and
under menu item Security select Deactivate PIN.

If the PIN code must be used, activate the [Use PIN] button in the TO-
PASS® operating software and enter the PIN in the field provided. Also
activate the PIN code for your SIM card using your cell phone.

Switch on the power to the TO-PASS® telecontrol module. The "Busy" LED
will begin flashing shortly after this.

In the operating software select the menu item Edit > Write parameters.
The operating software now transmits the parameters to the TO-PASS®
telecontrol module.

Wait until transmission is complete and the "COM" LED goes out.
Switch off the TO-PASS® telecontrol module.

Use a pointed object (e.g., screwdriver) to carefully slide the SIM card into
the SIM slot of your TO-PASS® telecontrol module until it locks into place.
The SIM card is then positioned 2 mm within the enclosure.

The SIM card can be released by pressing on it again.

Switch the TO-PASS® telecontrol module on again and wait until the
initialization phase is completed. Initialization is completed when the
"Busy" LED goes out.

Your TO-PASS® telecontrol module is now ready for use and can be
configured. Follow the instructions given in the Section "Configuration™ for
this.
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7 Parameterizing

7.1 General Settings

Select the menu item File > Settings for making general settings, such as type of
connection, interface or language for the TO-PASS® operating interface.

— Connection
* AS-232 © GSM " Analog O ISDM
todem init.: I
Area code; I
— Interface
|COM1 =]
— Language
{* English " Geman " French
Save Catricel

Figure 22: General settings

Table 26: General settings

Connection

RS-232/ GSM /

Analog / ISDN

Select the type of connection for communicating with the
TO-PASS® telecontrol module:

RS-232 Direct connection via RS-232 cable
GSM Dial-up using GSM modem on the PC
Analog Dial-up using analog modem on the PC
ISDN Dial-up using ISDN modem on the PC

Modem init.

If the connection is to be established via a modem and this

modem requires initialization, enter the initialization string in

this field.

Area code

If this connection is to be established via a modem at an
analog or ISDN PBX and a trunk code is required for this,
enter the trunk code in this field.
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Table 26: General settings

Interface

COML1 ... COMx |Here, select the serial interface where the communication
cable is connected with a RS-232 connection.

Language

English / Select the langauge for the TO-PASS® operator interface here.
German /
French

To apply the settings and close the dialog window, click [Save].

To close the dialog window without applying the settings, click [Cancel].
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7.2 Reading Parameters from the Module

After you have set the type of connection for communicating with the TO-PASS®
telecontrol module, you are then able to read out the parameters of the connected

module.

Select the menu option Edit > Read Parameters. The software then reads out all
the parameters of the TO-PASS® telecontrol module.

Then you can adapt the parameter according to your requirements.
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7.3

ldentity

[General:

Function zelection: IFW 233

Mame: [T0-PasS1

Phone number,  |0123456763

Select the TO-PASS® telecontrol module to be configured from the project tree;
under it, select the Identity option.

On the right side you will find the selection field for the function, the display field
for the name, the input field for the telephone number, buttons and input fields for
the PIN, roaming and prepaid and the input field for the alarm counter.

PIM: Ilze PIM
R oamino: Enable
Prepaid: I Search
Alarm counter: ID [1 ... 99 alarmz; 0 = inactive]

Figure 23: Configuring the identity
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Table 27: Configuring the identity

General

Function selection

You can redifine the firmware version in this selection field,
that is to say the available scope of functions (e.g., to ensure
compatibility with devices already in use).

When you define an older firmware version a check is first
conducted to determine whether the settings made for this
version can be used.

Name

The module name of the TO-PASS® telecontrol module is
displayed in this field. The module name is assigned when a
new module is set up and can only be changed later by
overwriting it with a new identity (not via a modem
connection).

Phone number

In this field enter the phone number of the SIM card used in
the module.

PIN

To use the PIN number of the installed SIM card, click the
[Use PIN] button and enter the PIN number in the field
provided.

Roaming

Roaming is always activated in TO-PASS® telecontrol
modules.

To select a favorite carrier, click the [Allow] button and enter
the 5-digit carrier ID in the field provided. The telecontrol
mode will then always attempt to use this favorite carrier
while roaming.

Prepaid

Click the [Poll] button to transmit information with the data
telegram to a prepaid card that you use. In the input field
enter the 5-digit polling code, e.g., "*100#" to determine your
remaining balance. Entering of a polling code is possible
starting with Firmware Version FW 2.33.

Alarm counter

Enter the maximum value in this field to limit the number of
alarms transmitted by the TO-PASS® telecontrol module each
hour.

If, in the event of a failure (e.g., loose connection), the
maximum number is exceeded, alarms will no longer be sent.
The alarm counter can be reset by an SMS being sent to the
TO-PASS® telecontrol module with the text "RESET", or by
switching the TO-PASS® telecontrol module off and then on
again.

Enter a value of "0" to deactivate limiting.
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7.4 Addresses

The TO-PASS® telecontrol module can communicate with a maximum of four
transmitters/receivers via GSM. Messages are sent by the TO-PASS® telecontrol
module as SMS; however, they can also be sent as an e-mail, fax or voice mail, as
defined in configuration.

The TO-PASS® telecontrol module can also transmit messages to an Internet
address.

Select the TO-PASS® telecontrol module to be configured from the project tree

and the option Addresses.
The input fields for the addresses are on the right side:

Phione/F 2t il

Addresz 1:

s

T2T

Address 2 T2T

Addressz & T2T

|
|
|
Address & | T2T
7

Call humber check: [1 ... 20 characters; 0 = inactive]

Internet:

Host address: I

Huost port: IEU

Script [value]:

Scrpt [logger]:

Izer name:

|
|
APN access: |
|
|

Pazzword:

Script werzion: I Fus 220 Pt 231 P 233

Figure 24: Configuring the addresses
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Table 28: Configuring the addresses

Phone/Fax/Mail

Address 1 ...
Address 4

Enter the target addresses in these fields:

Transmission as SMS:

Enter the mobile phone number of the recipient.

Click the button [T2T] when the SMS recipient is also a TO-
PASS® telecontrol module, e.g., when alarm messages are to
be used as switching commands in the other TO-PASS®
telecontrol module.

Transmission as e-mail:
First, enter the e-mail identifier for the provider of the SIM
card being used. The following identifiers may be used:

- T-Mobile: 8000
- VODAFONE: 3400
- E-Plus 7676245.

Enter a comma (,) after this identifier, followed by the e-mail
address, e.g., for a T-Mobile SIM card:
"8000,receiver@provider.net".

Transmission as fax:

Follow the instructions from the provider for transmissions as
fax messages. For T-Mobile or VVodafone, for example, enter
the identifier "99" directly in front of the fax number:

"99057123456789".

Number
check

In this field enter the number of digits to be used for number

checking. If the entered number is longer than the number of

digits entered in this field the last digits of the number will be
checked.

This function is available starting with Firmware Version FW

2.33.
Note

Address allocation is only possible when
number checking is activated!

Incoming SMS messages cannot be allocated to an
address in the memory when number checking is
not active, meaning, for example, that standby is
not possible. If there are delays in responding when
number checking is not activated, the target
address may be overwritten by a new SMS.

Manual
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Table 28: Configuring the addresses

Online

Host address

In this field enter the host address for the Web portal for test
purposes, e.d., "www.to-pass.com".

Host port

In this field enter the port for the Web portal (e.g., "80" for
most http applications)

Script (value),
for transmitting
alarms and status
messages

Script (Logger),
for transmitting
the data of the
logger

In this field enter the script name for data transmission, for
test purposes, e.g., "wago/saveTO-PASS.php".

The "saveTO-PASS.php" script checks the version
indications from transmitted data and forwards this
information to the processing script.

APN access*

In this field enter the APN access point (Access Point Name)
for the SIM card provider, e.g.,:

T-Mobile: "internet.t-mobile”
Vodafone: web.vodafone.de (The specified APN
is not valid for prepaid cards.)

User name* In this field enter the user name for SIM card provider access
point, e.g.,:
T-Mobile: Entry required, content - any
Vodafone: any
Password* In this field enter the password for the SIM card provider

access point, e.g.,:

T-Mobile: Entry required, content - any
Vodafone: any

Script version

Use this button to select the script version to define the
information that is to be transmitted to the Web portal.

* The examples for APN access, user name and password comply with the
information valid at the time this manual was written. The required entries can be
found in the current documentation of your SIM card provider.
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7.5 Configuring Inputs and Outputs
7.5.1 Digital Inputs
Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the input to be configured under Digital Inputs.
Digital inputs 1 ... 4 can be configured as counter inputs starting from Firmware
Version FW 2.33.
The counters count up or down from the given starting and end value.
With upward counting, exceeding of two counter values can be reported.
With downward counting, transgression of two counter values can be reported.
The parameters of the input are given on the right side.
The buttons and input fields for digital inputs 1 ... 4and 5 ... 8 (when provided)
are identical:
¥ Counters: Activate |
Starting walue: ID [0... 4294967 295]
End valug: |4234567295 [0... 4234967295]
Alarm settings:
™ First walue: IU [O... 42949672595]
Activation best: IDigitaI input et [1]
Address: LI _2| _3| _4| Inkermet |
anabgvave: 1| 2| 3| 4| s| & 7| s
Drelay tirme: IEIEI: j IEIEI: j IEIEI j [kh:rm:zs; 00:00:00 = inactive]
[ Second valus: IU [0... 42949672595]
Deactivation text: IDigitaI input reset [1]
Address: LI _2| _3| _4| Inkermet |
anogvave: 1| 2| 3| 4| 5| 6| 7| s
Drelay time: IEIEI: j IEIEI: j IEIEI j [kh:rm:zs; 00:00:00 = inactive]
Figure 25: Configuring digital inputs 1 ... 4
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Alarmn settings:
Activation test:
Address:
Analog walue:

Drelay time;

| Digital input set (5]

Al 2 5 4 oma |
4l 2l 3l 4] 5] o 7] s

foo: =] foo =] Joo =] [Wheromcss: 00:00:00 = inactive]

Dreactivation test: IDigitaI input reset [3)

Address:
Analog value:

Drelay fime:

] 2l 3] 4] et |
A e Y Y -1 ] e Y

fon: =] Joo. =] Joo =] [wkemomcss: D0:00:00 = inactive]

Figure 26: Configuring digital inputs 5 ... 8 (when provided)

Table 29: Configuring of digital inputs

Counters (only for digital inputs 1 ... 4)

Counters

Check this box to use the selected digital input as a counter
input.

To activate the counter click the button [Activate]. This
button is only active when the input is used as a counter
input. On completion of configuration, the counter can be
activated/deactivated during operation via the visualization
system.

This function is available starting with Firmware Version FW
2.33.

Starting value

In this field enter the starting value for the counter.
This field is only active when the input is used as a counter
input.

End value

In this field enter the end value for the counter.

This field is only active when the input is used as a counter
input.

If the starting value is less than the end value the counter will
count upward. If the end value is exceeded, the counting
process is restarted from the starting value.

If the starting value is greater than the end value the counter
will count downward. If counting then continues below the
end value, the counting process is restarted from the starting
value.

waco'

Manual
Version 2.0.0




WAGO-TO-PASS® 761 Parameterizing 61
761-216 TO-PASS® Compact, 8 Al, Web, MODBUS

Table 29: Configuring of digital inputs

Alarm settings

First value Check this box to have a message sent when the first limit is
exceeded for upward counting or when the first lower limit is
violated for downward counting.

In the field provided, enter the first limit for which a message
IS to be sent when this limit is violated (upper/lower limit)
(see below).

The check box and the input field are active only when the
input is used as a counter input.

Activation text In this field enter the text to be contained in the message
transmitted when the digital input has been set, or when the
counted value has violated the first limit.

Address Use this button to select the addresses to which the message
is to be transmitted when the digital input has been set, or
when the counted value has violated the first limit.

Click the button [Internet] for applications with GPRS
transmission.

Analog value Use these buttons to select up to four analog values which
can also be transmitted with the message when the digital
input has been set, or when the counted value has violated the
first limit.

Delay time In these fields select the time (in hours, minutes and seconds)
by which the message is to be delayed after setting of the
digital input.

If the input is reset before the defined delay period elapses,
no activation/deactivation message will be sent.

Enter "00:00:00" in this field to deactivate this function. The
message will then be sent immediately.

This function is available starting with Firmware Version FW

2.33.
The selection fields are active only when the input is used as
a digital input.

Second value Check this box to have a message sent when the second limit

is exceeded for upward counting or when the second lower
limit is violated for downward counting.

In the field provided, enter the second limit for which a
message is to be sent when this limit is violated (upper/lower
limit) (see below).

The check box and the input field are active only when the
input is used as a counter input.
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Table 29: Configuring of digital inputs

Deactivation text

In this field enter the text to be contained in the message
transmitted when the digital input has been reset, or when the
counted value has violated the second limit.

Address

Use this button to select the addresses to which the message
is to be transmitted when the digital input has been reset, or
when the counted value has violated the second limit.

Click the button [Internet] for applications with GPRS
transmission.

Analog value

Use these buttons to select up to four analog values which
can also be transmitted with the deactivation message when
the digital input has been reset, or when the counted value
has violated the second limit.

Delay time

In these fields select the time (in hours, minutes and seconds)
by which the message is to be delayed after resetting of the
digital input.

If the input is set again before the defined delay period
elapses, no activation/deactivation message will be sent.
Enter "00:00:00" in this field to deactivate this function. The
message will then be sent immediately.

This function is available starting with Firmware Version FW
2.33.

The selection fields are active only when the input is used as
a digital input.
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7.5.2 Multiplex Input

You can configure digital inputs DI1 ... D14 as multiplex inputs. These four inputs
will then additionally be read in as a combination and intepreted as a binary
number. The following applies in this case:

DI1=2%=1,
DI2=2'=2,
DI3 =2%=4and
DI4=23=8.

Thus, for example, if DI1 and DI3 are set, then the binary number is 5. If only D14
is set, then the binary number is 8.

In the multiplex table you can define an alarm message for each of the 16 statuses
(0 ... 15). The recipients of the messages can be selected using the multiplex
settings.

Note

Counter inputs cannot be evaluated as multiplex inputs!

Counter inputs cannot be evaluated as multiplex inputs, as these inputs cannot be
set.
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7.5.2.1

Multiplex Settings

Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the Multiplex Settings option under Multiplex Input.
The buttons for enabling multiplex operation and the selection of the recipients of
the analog values to be transmitted are provided on the right side.

Release/dddiesses:

ultiplex operation:

se |

Address: ENENENE ntemet |
Analog valle: 2l 2| 3] 4] 5| ef 7| sl

Figure 27: Configuring multiplex operation settings

Table 30: Configuring multiplex operation settings

Enable/Addresses

Multiplex
operation

Click the button [Use] to enable/disable multiplex operation
for digital inputs DI1 ... DI4.

If a status combination of digital inputs DI1 ... DI4 is fulfilled
in multiplex operation for which a message text has been
defined, a corresponding message will then be sent (see
below).

Address

Use this button to select the addresses to which the message
is to be transmitted when the corresponding status
combination of digital inputs DI1 ... DI4 is fulfilled.

Click the button [Internet] for applications with GPRS
transmission.

Analog value

Use these buttons to select four analog values which can also
be transmitted with the message text when the corresponding
status combination of digital inputs DI1 ... DI4 is fulfilled.
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7.5.2.2  Multiplex Alarm Text

Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the Multiplex Table option under the Multiplex Input
entry. The input fields for the alarm texts pertaining to the 16 statuses are
provided on the right side.

Alarm bexks:

Walue 0
Walue 1:
Walue 2
Walue 3:
Walue 4:
Walue 5:
Walue B
Walue 7
Walue 8
Walue 3:
Walue 10:
Walue 11:
Walue 12:
Walue 13:
Walue 14:
Walue 15

Figure 28: Configuring multiplex operation alarm texts

Table 31: Configuring multiplex operation alarm texts

Alarm texts
Value 0 ... Value |In these fields enter the texts to be transmitted in the message
15 when the corresponding status combination of digital inputs

DIl ... D14 are fulfilled.
Messages are not sent for status combinations without any
entries.
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7.5.3

Standardization:

Analog Inputs

Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the input to be configured under Analog Inputs. The
parameters of the input are given on the right side.

The buttons and input fields are identical for all analog inputs:

Input signal: | 0. 20me 4. 20ms |

Min. value: |0.00 [9999 ... 9399]

Ma, value: |20.00 (9339 ... 9359]

Uit |mé.

Alam seftings:

First value: |20.00 [ ising falling |
il |High analog alam (1]

Address: [l T2 e et Intemst |

Analog value: ﬂ ﬂ ﬂ ﬂ ﬁ ﬁ ﬂ ﬂ

Second value;

Alarn;

Addresz;

Analog value:

IEI,EIEI rizing | I falling

ILDW analag alarm [1]
A 2] 3] 4
Al 2] 3 4] 5| 8] 7] 8]

Inkermet |

Figure 29: Configuring the analog inputs

Table 32: Configuring the analog inputs

Standardization

Input signal

Use these buttons to select the input signal for the sensor
connected to the TO-PASS® telecontrol module.

Min. value

In this field enter the starting value from which the given
value is normalized. This value corresponds to the minimum
input current value of 0 mA or 4 mA.

Max. value

In this field enter the end value up to which the given value is
normalized. This value corresponds to the maximum input
current 20 mA.

Unit

In this field enter the unit with a maximum of 5 characters
with which the normalized process value is to be transmitted.
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Table 32: Configuring the analog inputs

Alarm settings

First value

In this field enter the first limit for which a message is to be
sent when this limit is violated (upper/lower limit) (see
below).

Use the buttons to select whether the message is to be sent for
violation of the upper [increasing] or lower limit value
[decreasing].

Message

In this field enter the text to be contained in the message
transmitted when the analog value has violated the first
(upper/lower) limit.

Address

Use these buttons to select the addresses to which the
message is to be transmitted when the analog value has
violated the first limit.

Click the button [Internet] for applications with GPRS
transmission.

Analog value

Use these buttons to select up to four analog values which
can also be transmitted with the message when the analog
value has violated the first (upper/lower) limit.

Second value

In this field enter the second limit for which a message is to
be sent when this limit is violated (upper/lower limit) (see
below).

Use these buttons to select whether the message is to be sent
for violation of the upper [increasing] or lower limit value
[decreasing].

Message

In this field enter the text to be contained in the message
transmitted when the analog value has violated the second
(upper/lower) limit.

Address

Use this button to select the addresses to which the message
is to be transmitted when the analog value has violated the
second (upper/lower) limit.

Click the button [Internet] for applications with GPRS
transmission.

Analog value

Use these buttons to select up to four analog values which
can also be transmitted with the message when the analog
value has violated the second (upper/lower) limit.
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7.5.4 Digital Outputs

Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the output to be configured under the entry Digital

Outputs.

The parameters of the output are given on the right side. The input fields are
identical for all digital outputs:

S ettingz:

Activation best:

[DOUTI=1

Deactivation text: IDEILIT[1 1=0

Dreactivation time: I':":'i j I':":'i j IDD j [bb:rmm:z2; 00:00:00 = inactive]

Figure 30: Configuring the digital outputs

Table 33: Configuring the digital outputs

Settings

Activation text

In this field enter the activation text for the output.

When the TO-PASS® telecontrol module receives this text as
an SMS it switches this digital input on and connects the DC
voltage available at terminal 37 to the corresponding output.

Deactivation text

In this field enter the deactivation text for the output.

When the TO-PASS® telecontrol module receives this text as
an SMS it deactivates this digital output and disconnects the
DC voltage available at terminal 37.

Turn-off time

In these fields select the turn-off time for the output in hours,
minutes and seconds.

If the digital output has been activated, it will remain active
for the time defined here and voltage remains applied at
terminal 37. When this time elapses, the output switches off
the voltage at terminal 37 automatically.

The maximum turn-off time is limited to "00:01:59" up to
Firmware Version FW 2.33.

Define a time of "00:00:00" hh:mm:ss to deactivate this
function. The output will then remain permanently activated
until the next deactivation message is received.
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7.5.5 Analog Outputs
Select your TO-PASS® telecontrol module from the left side of the project tree
using the identifier. Select the output to be configured under Analog Outputs.
The parameters of the output are given on the right side.
The buttons and input fields are identical for all analog outputs:
Standardization:
Output signak | 0. 20me 4. 20 mh
kdir. walue; I':I
b aw. walue: IZEI
[t Im.-i'-.
S et output:
Text: I"f""I:“'IT[-I =
Figure 31: Configuring the analog outputs
Table 34: Configuring the analog outputs

Standardization

Output Signal Use these buttons to select the output signal for the actuator
connected to the TO-PASS® telecontrol module.

Min. value In this field enter the starting value from which the output
value is normalized. This value corresponds to the minimum
output current value of 0 mA or 4 mA.

Max. value In this field enter the end value up to which the output value
is normalized. This value corresponds to the maximum output
current 20 mA.

Unit In this field enter the unit with a maximum of 5 characters
with which the normalized process value is to be transmitted.

Set output

Text In this field enter the text for setting the output.

If this text is transmitted with a value situated within the min.
and max. value, the TO-PASS® telecontrol module sets the
analog output to the specified value.
Manual W ®
Version 2.0.0 Aﬂﬂ




WAGO-TO-PASS® 761

70  Parameterizing
761-216 TO-PASS® Compact, 8 Al, Web, MODBUS

Note

Evaluation of places after the decimal point
Starting with Firmware 02.33.08, places after the decimal point are also taken into

account for switching of the analog outputs. A period (decimal point) "." must be
used as the separator. Up to four digits are evaluated. With a minimum value of 0
and a max. value of 20, two digits can be used after the decimal point, allowing a
value of "5.55" to be evaluated, for example. Configuring is performed without
places after the decimal point.
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7.6 Configuring Error Detectors

The TO-PASS® telecontrol module can transmit error messages to a maximum of
four recipients. The recipients are informed either directly one after another or (if
configured) after expiration of the time delay for acknowledgment. The message
is sent by the TO-PASS® telecontrol module as an SMS; however, it can also be
sent as an e-mail, fax or voice mail. In addition, the error messages can also be
transmitted to a Web portal.

Note
Device-dependent Function

Devices with GPRS functionality (device identifier "Web") are required to
transmit error messages to a Web portal.

Note
Note the calculation packet size!

Please note the information given on calculation packet size in the Section
"Important Information - Rounding of Blocks for GPRS Links."

7.6.1  Alarm Messages for Digital Inputs

If on or off states of digital inputs are to be sent as error messages, select the
desired recipient for the respective input statuses using buttons [1] ... [4]. Click
the [Internet] button to also transmit the message to a Web portal.

In addition, you can also specify the analog values that are to be transmitted along
with the error message.

7.6.2 Limit Messages for Counter Inputs

If violations of upper/lower counter limits are to be sent as error messages,
activate the respective counter value and select the desired recipient using buttons
[1] ... [4]

Click the [Internet] button to also transmit the message to a Web portal.

You can also specify the analog values that are to be transmitted along with the
error message.

7.6.3 Limit Messages for Analog Inputs

You can specify a maximum of 2 limit values for every analog input for which
(upper/lower) limit value violations are to be sent as error messages.

Enter the desired value and select whether the error message is to be sent for
violation of the upper or lower limit value using the buttons [increasing] or
[decreasing].

Select the desired recipient for the respective limit value using the buttons [1] ...
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[4]

Click the [Internet] button to also transmit the message to a Web portal.
In addition, you can also specify the analog values that are to be transmitted along

with the error message.
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7.6.4  Acknowledgement

Acknowledgment is the confirmation that a message has actually been sent to the
recipient. Select the TO-PASS® telecontrol module from the project tree using the
identifier. Select the entry Acknowledgment under the option Special Functions.
The right side contains the input fields for the waiting time, the number of
repetitions and the response text.

S ettings:
W aiting tirme:
Repetitions:

Responze text:

[0... 99 minLtes]

[0... 99 cycles]

IEJLIIT [max. 20 characters]

Figure 32: : Configuring the acknowledgment response

Table 35: Configuring the acknowledgement response

Settings

Waiting time

In this field enter the time that the TO-PASS® telecontrol
module waits for an acknowledgement after transmitting an
alarm SMS.

Acknowledgement is in the form of an SMS containing the
configured response text, or a simple call by the recipient to
the TO-PASS® telecontrol module.

The TO-PASS® telecontrol module registers the call.

You then receive an acknowledgement SMS containing the
identifier, the response text and the alarm text.

Repetitions

In this field enter the number of acknowledgement cycles.
If no recipient acknowledges the message of the TO-PASS®
telecontrol module, then the entire cycle can be executed
again, allowing the TO-PASS® telecontrol module to inform
the first address once again and to wait for an
acknowledgment.

Response text

In this field enter the SMS acknowledgement text (up to 20
characters).

This input field is available starting with Firmware Version
FW 2.33.
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7.7 Transmission Repeat Times

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the entry Repeat times under the option Special Functions. The input
fields for the Web interval, the Web outputs and the SMS interval and buttons for
target addresses are located on the right side.

Wieh settings:

YWieh interval; IU [O... 9939 min. to server]
[ Switched interval

Switching [nput; 0N =

Switching interval; ID [O... 9999 min. to zerver]

web outputs: po1 | ooz | obo3| opos | am | a0z |
SMS zettings:

S5 interval: ID [0... 99939 mir.]

Address: IT _2| _3| _4|
[~ Limited 5M5 transmission

Active time: fon: = foo- =] Jooo =) Joo =) ke - b

Active dayz: | tonday [T Tuesday [T wWednesday
™| Thursday ™| Friday ™| Saturday
[T Sunday

Figure 33: Configuring the transmission repeat times
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Table 36: Configuring the transmission repeat times

Web settings

Web interval

In this field enter the cycle time in minutes to define the
intervals that the TO-PASS® telecontrol module is to send
data to the Internet.

Enter a "0" to deactivate cyclical data transmission.

The maximum value that you can enter here is 9999 minutes,
which corresponds to around one transmission per week.

Note
Device-dependent function

The function is only available for devices with
GPRS functionality (device identification "Web").

Note
Note the calculation packet size!

Please note the information given on calculation
packet size in the Section "Important Information -
Rounding of Blocks for GPRS Links."

Switched interval

Check this box to have the transmission interval switched as
a function of the status of a digital input between Web
interval and switching interval.

This function is available starting with Firmware Version FW
2.33.

Switching input

In this field, select a digital input to be used for switching of
the transmission interval between Web interval (Off status of
the input) and the switching interval (On status of the input).
When the status of the switching input changes, the initial
transmission is triggered, followed by transmission at the
cycle time defined in the field Switching interval.

This selection field is active only when the Switched

interval box is checked.
Note

Counter inputs may not be defined as switching
inputs
Counter inputs may not be used as switching
inputs, as no status changes are evaluated for these
inputs.

Switching interval

In this field enter the cycle time in minutes to define the
intervals that the TO-PASS® telecontrol module is to send
data to the Internet.

Enter a "0" to deactivate cyclical data transmission.

The maximum value that you can enter here is also 9999
minutes.

Web outputs

Use these buttons to select the inputs whose default setpoints
can be modified via responses from the Web portal.

This function is available starting with Firmware Version FW
2.33.
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Table 36: Configuring the transmission repeat times

SMS Settings

SMS interval

Here, enter the cycle time in minutes to define the intervals
that the TO-PASS® telecontrol module is to send data to the
addresses defined under Address.

SMS content is specific to devices and firmware used and is
described in the Section "Operation — Remote Polling by
SMS".

The cyclic SMS can, for example, be used for operational
supervision.

Address

Use this button to select the addresses to which the message
is to be transmitted in defined cycles.

Limited SMS
transmission

Check this box to limit the SMS interval to certain days of
the week and to certain times of day.

Time adjustment must be performed for limited SMS
transmission to check the day of the week and the active
time.

The first SMS is transmitted when the starting value for the
active time on an active day is reached. The SMS is also
transmitted when a cycle time of "0" has been defined. The
transmission cycle is started when the cycle time is situated
within the active time.

This function is available starting with Firmware Version FW
2.33.

Active time

In these fields you can select the starting and end points for
the active time in "hh:mm".

The starting point must be before the end time. A selection
not in line with these requirements will be adapted
automatically.

These selection fields are active only when the box Limited
SMS transmission has been checked.

Active days

Check these boxes to mark the active days for SMS
transmission.

These boxes are active only when the Limited SMS
transmission box has been checked.

waco'
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7.8 Time Adjustment

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the entry Acknowledgment under the option Time setting. The buttons
for various settings pertaining to time adjustment are located on the right side.

S ettings:

Time adjuzstmemnt:

SkS Internet DCF

Figure 34: Setting the time adjustment

Table 37: Setting the time adjustment

Settings

Time adjustment

The TO-PASS® telecontrol module sends an SMS to itself and
receives the current time from the provider transmitted by
this SMS when the [SMS] button is clicked. Time
adjustment using an SMS takes place only once when the
TO-PASS® telecontrol module is restarted, or when an SMS
with the text "Time" is received.

When the [Internet] button is clicked, the TO-PASS®
telecontrol module takes the time from the response by the
Web portal on each transmission to the Web portal.

The transmission runtimes may cause time differences to
occur.

Manual
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7.9 MODBUS

The MODBUS functionality facilitates connectivity for MODBUS interface-
equipped devices. The devices must be configured as slave devices and are
connected via PC interface. As a result, the TO-PASS® telecontrol module
operates as a master.

A maximum of up to 64 registers can be queried.
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7.9.1

MODBUS Settings

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the MODBUS Settings option under the MODBUS entry.

The buttons for the MODBUS format and the input field for the polling cycle time
are provided on the right side:

Releaze/Format:

MODBLS farmat; I riok uzed j

Fead rate:; I'lD w10 ms

Figure 35: Configuring the MODBUS settings

Table 38: Configuring the MODBUS settings

Enable/Format

MODBUS format | Select the transmission format for MODBUS
communication; the format selected must be compatible with
the controller used.

The following formats are possible:

Not used (ho MODBUS connection)

9600 (8N2), RTU Input (0x04)

9600 (8E1), RTU Input (0x04)

9600 (801), RTU Input (0x04)

9600 (8N1), RTU Input (0x04)*

9600 (8N2), RTU Holding (0x03)*

9600 (8E1), RTU Holding (0x03)*

9600 (801), RTU Holding (0x03)*

9600 (8N1), RTU Holding (0x03)*

19200 (8N2), RTU Input (0x04)*

19200 (8E1), RTU Input (0x04)*

19200 (801), RTU Input (0x04)*

19200 (8N1), RTU Input (0x04)*

19200 (8N2), RTU Holding (0x03)*

19200 (8E1), RTU Holding (0x03)*

19200 (801), RTU Holding (0x03)*

19200 (8N1), RTU Holding (0x03)*

* These functions are available starting with Firmware
Version FW 2.33.

Polling cycle Here, enter the MODBUS subscriber polling cycle time in
multiples of 10 ms.

The requested MODBUS subscriber must reply within this
time. This means that the polling cycle time is a function of
the response time of the slowest subscriber.
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7.9.2 MODBUS Alarm

When using the MODBUS functionality, an input of a MODBUS device can be
defined that triggers an alarm when it assumes the high state (logical "1").

The alarm request is made via the function code "Read Discrete Inputs™ (0x02).
Alarm messages are also initiated for communication errors.

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the option MODBUS alarm under the MODBUS entry.
The input fields and buttons for the alarms are provided on the right side.

Alarm settingz [dizcrete input];

Module/R egister: ID IEI
Alarm text: [MODBUS-&larm

Address: LI _2| _3| _4| | nkernet

Figure 36: Configuring the MODBUS alarm

Table 39: Configuring the MODBUS alarm

Alarm Setting (Discrete Input)

Module/Register | Enter the address of the MODBUS subscriber in the Module
input field and the number of the register to be polled in the
Register column.

Alarm text In this field enter the message sent when the selected
MODBUS input assumes the high state or when the
MODBUS status is being modified.

Address Use this button to select the addresses to which the message
is to be transmitted when the MODBUS input has been set.
Click the button [Internet] for applications with GPRS
transmission.
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7.9.3 MODBUS Registers

A maximum of 64 registers can be read from the connected MODBUS
subscribers. The registers are compiled in four groups (1 ... 16, 17 ... 32, 33 ... 48,
49 ... 64).

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the option MODBUS Registers for the corresponding group under the
MODBUS entry.

The input fields for the addresses of the registers to be polled are provided on the
right side. The input fields are identical for all register groups:

Wariable table: moduledregizter/name [input reqister]:

[0 [0 !
lo [0 !
[0 |0 |
[0 |0 |
lo [0 !
[0 |0 !
[0 |0 !
lo [0 |
[0 |0 !
Io [0 !
lo [0 !
C [0 |
lo [0 !
[0 |0 !
[0 |0 !
Jo [0 !

Figure 37: Configuring the MODBUS registers

Table 40: Configuring the MODBUS registers

Variable table: module/register/name (input register):

Register 1* 16, Enter the address of the MODBUS subscriber in the Module
(Registers 17 ... column and the number of the register to be polled in the

32, Register column. You can enter a designator in the Name
Registers 33 ... 48, |(input register) column.

(Registers 49 ... Each value is read in as a 16-bit value and a maximum of 64
64) values can be read.

Manual

®
Version 2.0.0 WAE“



82  Parameterizing

WAGO-TO-PASS® 761
761-216 TO-PASS® Compact, 8 Al, Web, MODBUS

7.10

Data Logger

Select the TO-PASS® telecontrol module from the project tree using the identifier.
Select the entry Data Logger under the option Special Functions. The input field
for the cycle time and a button for calculating the average value are located on the

right side.

5 ettings:

Cycle tirme:

Average value:

[1 ... 99 minutes]

On

Figure 38: Configuring the data logger

Table 41: Configuring the data logger

Settings

Cycle time

In this field enter the cycle time in minutes at which the
process image is to be saved.

The process image is specific to devices and firmware used
and is described in the Section "Operation — Data Logger
(DSP)".

The data logger is a cyclic buffer; i.e., when the buffer is full,
the oldest process images are overwritten (F.1.F.O). The size
of the data logger depends on the device used and is specified
in the technical data sheet.

Average value

Press the [On] button to switch average value calculation on
or off.

If average value calculation is on, the analog input values
read at a sampling rate of 10 ms are added within a cycle
time. The total is than divided by the number of values read
in the cycle time and saved.
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7.11  Writing Parameters to the Module

After you have adapted all parameters for the TO-PASS® telecontrol module to
your requirements, you have to write the parameters to the connected module.

Select the menu option Edit > Write Parameters. The software then writes all
parameters to the TO-PASS® telecontrol module.

After the COM LED goes out, the TO-PASS® telecontrol module is ready for
operation.
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8 Operation

8.1 Remote Query of Process Values

The TO-PASS® telecontrol module offers two options for remote inquiry of the
process values available:

. Query via SMS
. Query with the TO-PASS® Operator Program

Manual
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8.1.1 Remote Polling via SMS
For remote polling via SMS, send an SMS containing the text "State" to the TO-
PASS® telecontrol module.
The TO-PASS® telecontrol module responds promptly with an SMS to your
mobile phone containing all of the current process values.
Table 42: SMS format
Value transmitted: Meaning
Module 1 Identity
10010011 Condition of the digital inputs 1 ... 8
(0 = not set, 1 = set)
+00.00mA Analog input 1
+00.00mA Analog input 2
+00.00mA Analog input 3
+00.00mA Analog input 4
+00.00mA Analog input 5
+00.00mA Analog input 6
+00.00mA Analog input 7
+00.00mA Analog input 8
0110 Condition of the digital outputs 1 ... 4
(0 = not set, 1 = set)
+00.00mA Analog output 1
+00.00mA Analog output 2
Normal Status Status text or prepaid information (optional)
AC=99 Alarm counter
(displays the alarms that are still possible per hour).
The alarm counter only transmitted when enabled (Alarm
counter parameter in the Identifier dialog <> "0").
If at least one digital input is configured as a counter input, the counter status is
added to the SMS. The additional lines are added in front of the "Status text" line.
The counter status shows the last change that has occurred since the last SMS
transmission, or after a system start (independent of the value and logger status).
Example:
Table 43: Items added to SMS for counter inputs
Value transmitted Explanation
0 Status counter 1 (no counter)
€34560000 Status counter 2 (counter active, counter value =
34560000)
C10000000 Status counter 3 (counter value changed, value =
10000000)
RO Status counter 4 (counter reset, value = 0)
Manual
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The counter status may be one of the following statuses:

Table 44: Counter status

Status |Explanation

0 Digital input not configured as a counter.

e:ZW | Counter is active: Counter value.

d:ZW |Counter is not active: Counter value.

0:ZW |Counter overflow: Counter vlaue.

r:ZW |Counter has been reset: Counter value.

s:ZW |Counter has been started: Counter value.

c:ZW |Counter value has been changed: Counter value.

W Counter value
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8.1.2 Remote Polling using the TO-PASS® Operating Program

To display the process values with the TO-PASS® operator program, select the
menu item Visualization > Process values. The program establishes a link to the
TO-PASS® telecontrol modules selected. Please note the mode used to dial up the
TO-PASS® telecontrol modules, either via direct RS-232 cable connection or an
analog ISDN or GSM modem dial-up. The selection is specified in the menu
option File > Settings.
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8.1.2.1  Inputs/Outputs

Press the [I/0O] button to display the process values of the inputs and outputs. The
process values displayed are valid if the on-line display is green.

E
|III MODEUS | GPS | Counters | I Oriline
— Diigital input:
Input 1: Input 2: Input 3: Input 4: Input 5: Input B: Input 7: Input 8:
—&nalog input:
Input 1: Input 2: Input 3: Input 4: Input 5: Input B: Input 7: Input 8:

0,00/2000 md  4.00/20,00ms  400/2000ms  4.00/2000 ma 40042000 md 4002000 s 40042000 md  4,00420,00 ma,

0,00 m j4.00 m {3.90 mA [3.90 mA [3.90 m, [3.90 ma (.90 mA [3.90 mA
20,00 mé 20,00 mé 20,00 mé 20,00 mé 20,00 mé 20,00 mé 20,00 mé 20,00 mé
F 0,00 P 400 E 4,00 E 4,00 E 4,00 E 4,00 E 4,00 E 4,00
— Digital output
Output 1: Output 2 Output 3 Olutput 4:
I D D
oo | onof | ook | ook |

—Analog outputs

Output 1: Output 2
0100 % 4720 méy
0.0% 400 ma
Set | Set I

Figure 39: Visualization of the process values

Process values pertaining to inputs are displayed in the upper portion of the
window and those pertaining to digital and analog outputs are displayed in the
lower portion of the window.

Digital inputs configured as counter inputs are highlighted in blue.

Note

Displaying the Analog Values

The process values of the analog inputs and outputs are displayed with 8-bit
resolution.
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8.1.2.2

MODBUS

Press the [MODBUS] button to display the MODBUS process values. The
process values displayed are valid if the on-line display is green.

TO-PASSE process values
[T

1#0

—MODEUS alarm

aPs |

Counters |

I Online

E|

Module / Register / Text  Walue [Alarm / Statusz]
IDDD S 00000 f Modbus-Alarm o/ z

—MODEUS wariable:
Module / Register / Text  Value [Dec / Hex / Bin)
0ol / 00000 / 1. C2{-8Z0) Device Type QoQo0 4 0000 ¢ 00000000 00000000 -
ool f o000z f 1. CE(-520) Error Code Qoooo [/ o000 f 00000000 oooo0oooo0
o0l f ooo04 f 1. C3(-5E0) Measurement Qoooo 4 o000 f 00000000 oooo0oooo0
ool f 00ooe f 1. CE(-8Z0) Exception Code Qoooo 4 o000 f 00000000 oooo0oooo
ooz f 00000 S Z. CE(-6E0) Dewice Type Qoooo [/ o000 f 00000000 ooooooon
Qo f 0000z f EZ. CE({-6Z0) Error Code Qaodo / 0000 ¢ 00000000 Q0000000
Qoz / oo0o04 S Z. CE(-5Z0) Measurement Qoooo [/ 0000 00000000 QooQoooo0
ooz f 0000& J Z. C3(-6Z0) Exception Code Qoooo 4 0000 f 00000000 ooo0oooo0
ooo s oooooo S Qoooo 4 o000 f 00000000 oooooooo0
ooo o ooooo S Qoooo [/ o000 f 00000000 oooooooo
ooo [ oooooo S Qoooo [/ o000 f 00000000 oooo0oooo0
QaQ / 00000 [/ QoQoo 4 0000 ¢ 00000000 00000000
ooo f oooooo S Qoooo [/ o000 f 00000000 oooooooo0
ooo s o ooooo S Qoooo 4 o000 f 00000000 O0o0o0ooo0
ooo s oooooo S Qoooo 4 o000 f 00000000 oooo0oooo0
ooo /o ooooo S Qoooo [/ o000 f 00000000 oooo0oooo
Qoo ooodo S Qaodo / 0000 ¢ 00000000 Q0000000
ooo /o ooooo S Qoooo [/ o000 f 00000000 oooo0oooo0
ooo o ooooo S Qoooo 4 o000 f 00000000 oooo0oooo0
ooo o ooooo S Qoooo 4 o000 f 00000000 oooo0oooo
ooo o ooooo S Qoooo [/ o000 f 00000000 ooooooon
ooo o ooooo S Qoooo [/ o000 f 00000000 oooooooo
Qoo /o aoooo S Qoooo [/ 0000 00000000 QooQoooo0
ooo /o ooooo S Qoooo [/ o000 f 00000000 oooo0oooo ‘:J

Figure 40: MODBUS process values

MODBUS Alarm
In this line, the variable for the MODBUS alarm (Module/Register/Text) is
displayed with the corresponding value (Alarm/Status).

MODBUS Variables
In this table, the MODBUS variables (Module/Register/Text) are displayed with
the corresponding values (Dec/Hex/Bin).
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8.1.2.3

Counters

To display the counter process values, click the [Counter] button (possible only
when inputs have been configured as counters). The process values displayed are
valid when the on-line indicator is highlighted in green.

TO-PASSE process values I

o | wooeus | ie || [ [ Drine
— Counter statu
Input 1: Input 2: Input 3: Input 4:
I Activate Activate I Achivate I Activate I
Deactivate II Deactivate Deactivate I Deactivate I
Reset | Reset I Feset I Feset I
~ Counter walue
Input 1: Input 2: Input 3: Input 4:
04 34560000/ 0/ o/
43200000 0 43200000 4294967295
0 34560000
[ 43200000 34560000 [ 43200000 [ 4294967295
1] 1] 1] 1]
| 0| 24560000 | alf 0
Set | Set I Set I Set I

Figure 41: Counter process values

The counter statuses are shown at the top of the window, while the counter values,
the starting and end values and the limits are shown at the bottom.
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8.2 Telecontrol

TO-PASS® telecontrol modules offer the option of influencing a process remotely
with the help of their analog and digital outputs. There are two methods available:

. Telecontrol via SMS
. Telecontrol with the TO-PASS® operator program.
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8.2.1

8.2.1.1

Telecontrol via SMS

Setting or Resetting a Digital Output

To set or reset a digital output, send an SMS with the text that is entered under
Activation text or Deactivation text for the output to the TO-PASS® telecontrol
module. The TO-PASS® telecontrol module acknowledges the command with an
SMS containing the identifier and the transmitted text.

Example:

Table 45: Example of parameters for Set DO

Parameter Setting
Activation text DOUT1=1
Deactivation text DOUT1=0
Turn-off time 00:00:00

Send an SMS with the text "DOUT1=1" to the TO-PASS® telecontrol module to
switch on output 1. The TO-PASS® telecontrol module acknowledges the
command with an SMS with the identifier and the text "DOUT1=1 OK!".

Send an SMS with the text "DOUT1=0" to the TO-PASS® telecontrol module to
switch off output 1. The TO-PASS® telecontrol module acknowledges the
command with an SMS with the identifier and the text "DOUT1=0 OK!"
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8.2.1.2

Setting an Analog Output

To set an analog output, send an SMS with the text, which is entered under Set
output, and the value to be set to the TO-PASS® telecontrol module. The TO-
PASS® telecontrol module acknowledges the command with an SMS containing
the identifier, the transmitted text and the set value.

Example:

Table 46: Example of parameters for Set AO1

Parameter Setting
Output Signal 0..20 mA
Min. value 0

Max. value 100

Unit %

Text AOUT1=

Send an SMS with the text "AOUT1=75" to set analog output 1 to a value of 15
mA = 75%. The TO-PASS® telecontrol module acknowledges the command with
an SMS containing the identifier and the text "AOUT1=+00075% OK!".

Starting with Firmware 02.33.08, places after the decimal point are also taken into
account for setting of the analog outputs. A period (decimal point) "." must be
used as the separator. Up to four digits are evaluated. For 0 .... 100%, one digit
remains to be used after the decimal point, allowing a value of "75.5" to be
evaluated, for example.

"AOUT1=+075.5%0K!" is transmitted as a reply.
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8.2.1.3 Changing the Counter Value or Status

To change the value or the status of a counter, send an SMS containing the text
"Counter" and the corresponding control commands (more than one can be sent)
to the TO-PASS® telecontrol module.

The control commands identify the counter input and the actual command.

Table 47: Control commands for counters

Control command |Function
Cx=(x:1..4) Select counter 1 ... 4
E Activate counter

D Deactivate counter
R Reset counter

n (e.g., 500) Set counter value

Control commands must be concluded with a semicolon (*;").

The TO-PASS® telecontrol module acknowledges the command with an SMS
containing the identifier and the transmitted text.

Example:

To activate Counter 2 and set it to 500, and to also deactivate Counter 3, send an
SMS containing the text "Counter: C2=E C2=500 C3=D;" to the TO-PASS®
telecontrol module.

The TO-PASS® telecontrol module acknowledges the command with an SMS
containing the identifier and the text "COUNTER: OK!".
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8.2.2 Telecontrol with the TO-PASS® Operator Program

To display the process values with the TO-PASS® operator program, select the
menu item Visualization > Process values. The program establishes a link to the
TO-PASS® telecontrol modules selected. Please note the mode used to dial up the
TO-PASS® telecontrol modules, either via direct RS-232 cable connection or an
analog ISDN or GSM modem dial-up. The selection is specified in the menu
option File > Settings.
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8.2.2.1

Inputs/Outputs

Press the [I/0O] button to display the process values of the inputs and outputs. The
process values displayed are valid if the on-line display is green.

|
|III MODEUS | GPS | Counters | I Oriline
— Diigital input:
Input 1: Input 2: Input 3: Input 4: Input 5: Input B: Input 7: Input 8:
—&nalog input:
Input 1: Input 2: Input 3: Input 4: Input 5: Input B: Input 7: Input 8:

0,00/2000 md  4.00/20,00ms  400/2000ms  4.00/2000 ma 40042000 md 4002000 s 40042000 md  4,00420,00 ma,

0,00 m j4.00 m {3.90 mA [3.90 mA [3.90 m, [3.90 ma (.90 mA [3.90 mA
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— Digital output
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—Analog outputs

Output 1: Output 2
0100 % 4720 méy
0.0% 400 ma
Set | Set I

Figure 42: Visualization of the process values

Process values pertaining to inputs are displayed in the upper portion of the
window and those pertaining to digital and analog outputs are displayed in the
lower portion of the window.

Digital inputs configured as counter inputs are highlighted in blue.

Note

Displaying the Analog Values
The process values of the analog inputs and outputs are displayed with 8-bit
resolution.

You can set or reset the digital outputs by pressing the [Set/Reset] buttons.

To set an analog output, enter the required numerical value in the corresponding
input field and then click the associated button [Set].
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8.2.2.2 Counters

To display the counter process values, click the [Counter] button (possible only
when inputs have been configured as counters). The process values displayed are
valid when the on-line indicator is highlighted in green.
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0 | mooBus | ie || [ [~ Gnine
— Counter statu
Input 1: Input 2: Input 3: Input 4:
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Deactivate II Deactivate Deactivate I Deactivate I
Reset | Reset I Feset I Feset I
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Input 1: Input 2: Input 3: Input 4:
04 34560000/ 0/ o/
43200000 0 43200000 4294967295
0 34560000
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Figure 43: Counter process values

The counter statuses are shown at the top of the window, while the counter values,
the starting and end values and the limits are shown at the bottom.

To start a counter, click the button [Activate].
To stop a counter, click the button [Deactivate].
To restore the counter to its starting value, click the button [Reset].

To set a counter to a new value, enter the required counter value in the
corresponding input field and then click the associated button [Set] to apply the
new value.
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8.3

Acknowledging Error Messages

If a waiting time not equal to 0 has been set for the acknowledgment of error
messages, the TO-PASS® telecontrol modules expects an acknowledgment of error
messages from the recipient.

Acknowledgement is in the form of an SMS containing the configured response
text, or a simple call by the recipient to the TO-PASS® telecontrol module.

The TO-PASS® telecontrol module registers the call.

You then receive an acknowledgement SMS containing the identifier, the
response text and the alarm text.

Note

Acknowledgement by phone call is based on the card being used!

Some data cards do not allow voice links, meaning that acknowledgement is only
possible via SMS.

If the message is not acknowledged within the defined waiting time, the TO-
PASS® telecontrol modules sends the error message automatically to the next
recipient entered under addresses and waits again for the defined waiting time for
an acknowledgment.

If none of the defined recipients acknowledge the error message and the number

of repetitions is not set to 0, then the procedure is repeated either until a recipient
acknowledges the error message or the maximum number of repetitions has been
reached.
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8.4

Switching to Standby

Note

Standby authorization
Switching standby on and off is only possible by subscribers whose telephone
number has been entered in the address list!

Using the "Standby" function, it is optional to change all messages sent by the
TO-PASS® telecontrol modules specifically to the respective ready state. This
takes place with simple changeover via SMS.

To do this, just send an SMS with the text "Standby1" to the TO-PASS®
telecontrol modules. The TO-PASS® telecontrol module then transmits all alarm
messages to the SMS sender. Other receivers defined in the TO-PASS® telecontrol
modules are no longer informed.

To switch this function off, send an SMS with the text "Standby0" to the TO-
PASS® telecontrol modules.

The TO-PASS® telecontrol module sends the SMS “STANDBY OK!” at the start
of the standby function and the “STANDBY END!” at the end of the standby
function.
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8.5

Displaying the Data Logger (DSP)

The TO-PASS® telecontrol module is equipped with a data logger. The size of the
data logger depends on the device used and is specified in the technical data.

A process image contains all of the digital and analog inputs available at the TO-
PASS® telecontrol module. Starting with Firmware Version 2.31, the process
image will also contain all analog and digital outputs and, starting from Firmware
Version 2.33 all of the counter statuses and counter values.

The cycle time with which the process image is to be saved can be configured.
The average value can also be provided for the analog input values for cyclical
storage.

To read the contents of the data logger, select the menu item Edit > Read all data
records. Then display all values of the data logger using the menu item
Visualization > Data logger.

Either select all inputs or only specific inputs with the help of the selection field in
the upper portion of the window.

All entries are displayed as a table with the complete process image. Digital inputs
and outputs are displayed as bar charts; analog inputs and outputs as a curve
diagram.

Above the table or the diagram, the date and time of the first value displayed is
shown on the left side, and, on the right side, the date and time of the last value
displayed.

The navigation buttons on the right side of the window have the following
meaning:

Table 48: Navigation DSP

Butto Function

Jumps to the first data record of the table or the diagram

Jumps to the previous data record

Goes back by 20 data records

Goes forward by 20 data records

Jumps to the next data record

Jumps to the last data record of the table or the diagram

Pages the table or the diagram back to the first data record

Stops paging in the table or the diagram

Pages the table or the diagram forward to the last data record
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As an alternative, you can also display all data records saved via Edit > Display
all data records or all new data records for the selected telecontrol module via

Edit > Display new data records. Here, no distinction is made between DSP or
ESP.
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8.6 Displaying the Event Logger (ESP)

In contrast to the data logger, the event logger saves the complete process image
of the TO-PASS® telecontrol modules only when an event occurs. This can be the
setting of a digital input or even the violation of a limit value. All digital and
analog values available at the TO-PASS® telecontrol modules are saved.

To read the contents of the event logger, select the menu option Edit > Read all
data records. It is possible to display all values of the event logger with the help
of the menu option Visualization > Event logger.

Either select all events or only specific events with the help of the selection field
in the upper portion of the window.

The events are displayed in a list with the date, time and the event text.

As an alternative, you can also display all data records saved via Edit > Display
all data records or all new data records for the selected telecontrol module via
Edit > Display new data records. Here, no distinction is made between DSP or
ESP.
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9 Diagnostics
9.1 Test Inputs and Outputs
To test the inputs and outputs select the menu option Controller > Test 1/0O.
The following window is displayed:
Check TO-PASSE input/output
— Digital input:
I I I D D N -
Input 1 | Input 2 | Input 3 | Input 4 | Input & | Input & I |nput 7 I Input 8 I
—Analog input:
Input 1: Input 2: Input 3: Input 4: Input & Input E: Input 7: Input &
0,00 mé 4.00 mé geams | 988ma | 988ma | 988mA |  988ma |  988ma
— Digital outputs
I I I
Output 2 | Output 3 | Output 4 |
—inalog outputs
Output 1: Output 2:
0,00 i 400 e,
Set Set
QK |
Figure 44: Test inputs and outputs
The process values of the inputs are displayed in the upper area and the process
values of the outputs are displayed in the lower area.
By pressing the buttons [Output 1] ... [Output 4] in the upper area switch digital
inputs on and off.
A value range of 0 mA ... 20 mA and 4 mA ... 20 mA is defined for the analog
outputs. No decimal places can be entered.
Enter the required numerical value and click the [Set] button to set the analog
outputs.
Once the output has been set, the imported value is normalized with decimal
places.
Click [OK] to end the test and close the window.
Alternatively, the inputs and outputs can also be tested with the help of the menu
option Visualization > Process values.
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9.2

Testing the Counter Inputs

To test the counter inputs, select the menu item Edit > Test counters.

TestT0-paSSE counter
r— Counter statu
Irput 1: It 2 Input 3: Input 4:
I Activate Activate I Activate | Activate I
Deactivate | I Deachvate Deactivate | Deactivate I
Reset I Feset I Feset | Feset I
r— Counter value
Input 1: Input 1: Input 1 Input 1;
o/ J4ER0000S o/ o/
43200000 ] 43200000 4294967295
0 | 34560000 | - -
[ 43200000 345R0000 [ 43200000 [ 4294967295
i ] a a
| o | 34560000 | i o
Set I Set I Set | Set

Figure 45: Testing counters

The counter statuses are shown at the top of the window, while the counter values,
the starting and end values and the limits are shown at the bottom.

To start a counter, click the button [Activate].

To stop a counter, click the button [Deactivate].

To restore the counter to its starting value, click the button [Reset].

To set a counter to a new value, enter the required counter value in the
corresponding input field and then click the associated button [Set] to apply the

new value.

Click [OK] to end the test and close the window.

Alternatively, the counter inputs can also be tested using the menu item

Visualization > Process values.
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9.3 Testing the Connection

. Note
Direct serial link required

The connection may only be tested with a direct serial link to the TO-PASS®
telecontrol module.

To test the connection, select the menu option Edit > Test SMS/GPRS. The
following window is displayed:

Address: IT _2| _3| _4| Intermet

Inztructured string [zent with data]:

Send I

Ok, I

Figure 46: Testing the connection

Select the address to send an SMS to and enter the text to be sent. Click the
[Send] button to send the message. The status of the transmission is then

displayed.

Click [OK] to end the test and close the window.
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9.4 Testing the Modem

. Note
Direct serial link required

The modem test may only be performed with a direct serial link to the TO-PASS®
telecontrol module.

To test the mode, select the menu item Modem > Test.
The following window is displayed:

Modem test

IM::u:Iem it fovnd!

Iritialization:

Mebwork: IN::-t logged in - Metwork, zearch]

Signal: llllllllll I 0%

Figure 47: Testing the modem

A link to the modem is established and the signal strength displayed.

Click [OK] to end the test and close the window.
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10 WAGO TO-PASS® Web

10.1  Setting Parameters

Select the TO-PASS® telecontrol module to be configured from the project tree.
Select the Addresses option in order to enter the parameters for transmission to a
Web portal.

You can initially use our WAGO TO-PASS® portal for test purposes.

To do this, enter "www.to-pass.com™ as the Host address and the value 80" as
the Host port. Enter "wago/saveTO-PASS.php" as the script name under Script
(Values) and/or under Script (Logger).

Enter the information for your SIM card provider for APN access, user name and
password (see also Section “Parameter setting” > “Addresses”).

Under Special Functions, select Repetition Time and set the WEB Interval for
the cyclic transmission to the Web portal, e.g., 5 minutes.

Select the messages that are also to be sent to the Web portal, and click the
[Internet] button.

Communication as SMS or to the Web portal can be tested under the menu item
Processing > Test SMS/GPRS. Click the [Internet] button and enter any text,
such as “TEST” in the field Unstructured Text. Then click [Send]. The reply
"Web Refresh = 0" should follow after approx. 20 seconds.

Now go to the Web address www.to-pass.com and click [MyTO-PASS]. Enter
“test” as the user name and “test” as the password.

Now select your TO-PASS® telecontrol module from the following list and click
the [Display] button.
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10.2

10.2.1

HTTP Request

The HTTP method "POST" transmits the process image of the TO-PASS®
telecontrol module to the Internet to the WAGO TO-PASS® portal. A data set
consists of form data in the context of the request (header and data string).

All data is transmitted in a string (ASCII characters) without any line breaks.
Individual variables are separated by the “&” character.

Example HTTP Request

The HTTP request consists of both header and data string, which are separated by
an empty line (KCR><LF> = Carriage Return + Line Feed).

To improve readability line breaks have been inserted within the data string.

POST /wago/saveTO-PASS.php HTTP/1.0<CR><LF>

Host: www.to-pass.com<CR><LF>

Content type: application/x-www-form-urlencoded<CR><LF>
Content length: 249<CR><LF>

<CR><LF>

ID=TO-PASS;12345&PA=0000;home ;99

&T1=11/05/05,14:34:21
&D1=1;0&D2=0;0&D3=0;0&D4=0;0&D5=0;0&D6=0;0&D7=0;0&D8=0;0
&A1=+00.00;mA;0&A2=+00.00;mA; 0&A3=+00.00; mA; 0&A4=+00.00;mA;0
&A5=+00.00;mA; 0&A6=+00.00; mA; 0&A7=+00.00;mA; 0&A8=+00.00;mA;0
&US=Test measuring points
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10.3

10.3.1

Data Sets

To distinguish the structure of the incoming data sets, the new data sets are
marked with a version variable. The variable is structured as “xx.yy”, while “xx”
is changed for major modifications and “yy” is changed for minor extensions.

In the data set descriptions, the maximum number of characters is indicated in
square brackets.

Starting from Firmware Version 02.33.08, you can select the script version to be
applied to data transmission.

The scope of functions is limited for older script versions (e.g., counter inputs not
accounted for).

Value Script

Data transmission to the value script is activated via alarm, cyclical transmission
repetitions (Web interval) or connection test. Data packet information contains the
process image at the time of activation.
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10.3.1.1 Value Script FW 2.20 (Standard)

Table 49: Data format for value script FW 2.20 (Standard)

Index |Variable | Contents Format

0 ID Identity Identity[8];Serial number[5]
1 PA Parameter Cycle time[4];Provider[5];Alarm counter[2]
2 TI Date, time YY/MM/DD,hh:mm:ss;

3 D1 Digital input 1 Value[1];Alarm[1]

4 D2 Digital input 2 Value[1];Alarm[1]

5 D3 Digital input 3 Value[1];Alarm[1]

6 D4 Digital input 4 Value[1];Alarm[1]

7 D5 Digital input 5 Value[1];Alarm[1]

8 D6 Digital input 6 Value[1];Alarm[1]

9 D7 Digital input 7 Value[1];Alarm[1]

10 D8 Digital input 8 Value[1];Alarm[1]

11 Al Analog input 1 Value[6];Unit[5];Alarm[1]
12 A2 Analog input 2 Value[6];Unit[5];Alarm[1]
13 A3 Analog input 3 Value[6];Unit[5];Alarm[1]
14 A4 Analog input 4 Value[6];Unit[5];Alarm[1]
15 A5 Analog input 5 Value[6];Unit[5];Alarm[1]
16 Ab Analog input 6 Value[6];Unit[5];Alarm[1]
17 AT Analog input 7 Value[6];Unit[5];Alarm[1]
18 A8 Analog input 8 Value[6];Unit[5];Alarm[1]
19* uUs Unstructured string Data[40]

20** | MA MODBUS alarm Value[2];Status[2];Alarm[1]
21** | MV MODBUS variables 64 x Value[4]

22*** | PO GPS position String data[75]

* The variable is sent only if a Web refresh occurs via serial interface. ** The
variables are sent only if MODBUS is switched on.
*** The variable is sent only if the GPS functionality is available in the TO-
PASS® telecontrol module.

Note

Alarm marker for the multiplex function

When the multiplex function is used, the alarm markers for D1 to D4 are all '1' for
a multiplex alarm.
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10.3.1.1.1 Example of Value Script FW 2.20 (Standard)

To improve readability, line breaks have been inserted.

ID=TO-PASS ;12345

&PA=0000;home ;99

&T1=11/05/05,14:34:21
&D1=1;0&D2=0;0&D3=0;0&D4=0;0&D5=0;0&D6=0;0&D7=0;0&D8=0;0
&A1=+00.00;mA;0&A2=+00.00;mA;08A3=+00.00;mA;0&A4=+00.00;mA;0
&A5=+00.00;mA;0&A6=+00.00;mA;08&A7=+00.00;mA;0&A8=+00.00;mA;0
&US=Hello
&P0=123155.000,5217.9742N,00855.2710E,4.4,74.9,2,214.30,6.0,3.2,
110505.00
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10.3.1.2 Value Script FW 2.31 (Extended)

Due to extended functionalities, the value script has been extended to include a
version designation ("01.01") as well as supply voltage, output values and GPS
information. Furthermore the identity may also be up to 16 characters long.

Table 50: Data format for value script FW 2.31 (extended)

Index |Variable |Contents Format

0 ID Identity Identity[16];Serial number[5]

1 SV Value script version Version number[5] (currently “01.01)
2 PA Parameter Cycle time[4];Provider[5];Alarm counter[2]
3 TI Date, time YY/MM/DD,hh:mm:ss;
4 D1 Digital input 1 Value[1];Alarm[1]

5 D2 Digital input 2 Value[1];Alarm[1]

6 D3 Digital input 3 Value[1];Alarm[1]

7 D4 Digital input 4 Value[1];Alarm[1]

8 D5 Digital input 5 Value[1];Alarm[1]

9 D6 Digital input 6 Value[1];Alarm[1]

10 D7 Digital input 7 Value[1];Alarm[1]

11 D8 Digital input 8 Value[1];Alarm[1]

12 Al Analog input 1 Value[6];Unit[5];Alarm[1]

13 A2 Analog input 2 Value[6];Unit[5];Alarm[1]

14 A3 Analog input 3 Value[6];Unit[5];Alarm[1]

15 A4 Analog input 4 Value[6];Unit[5];Alarm[1]

16 A5 Analog input 5 Value[6];Unit[5];Alarm[1]

17 A6 Analog input 6 Value[6];Unit[5];Alarm[1]

18 AT Analog input 7 Value[6];Unit[5];Alarm[1]

19 A8 Analog input 8 Value[6];Unit[5];Alarm[1]

20 S Supply voltage Value[6];Unit[5];Alarm[1]

21 DO Digital outputs 4 x Value[1]

22 AO Analog outputs 2 x (Value[5];Unit[5];)

23* uUs Unstructured string Data[40]

24** | PO GPS position String data[75]

25** |Gl GPS information Deviation[5];8 x Flag[1];

26*** | MA MODBUS alarm Value[2];Status[2];Alarm[1]

27*** | MV MODBUS variables 64 x Value[4]

**

This variable is sent only if a connection test is performed via the serial
interface (SMS test).
This variable is sent only if the GPS functionality is available in the TO-
PASS® telecontrol module.
*** These variables are sent only if MODBUS is switched on.

Note

Alarm marker for the multiplex function
When the multiplex function is used, the alarm markers for D1 to D4 are all '1' for

a multiplex alarm.
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Table 51: Meaning of flag

Flag 1 | Flag 2 Flag 3 | Flag 4 | Flag 5 | Flag 6 | Flag 7 | Flag 8
Flag 1 0: | GPS has not been started.
1: | GPS has been started.
Flag 2 0: |Position deviation is not enabled.
1: |Position deviation is enabled.
Flag 3 0: | GPS receiver is turned off.
1: | GPS receiver is turned on.
Flag 4 0: | No valid position available.
1: | Valid position available.
Flag 5 0: |Static mean value is being calculated in the upper area.
1: | Static mean value calculation is complete in the upper area.
Flag 6 0: |Static mean value is being calculated in the lower area.
1. |Static mean value calculation is complete in the lower area.
Flag 7 Reserved
Flag 8 Reserved
Manual W ®
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10.3.1.2.1 Example of Value Script FW 2.31 (Extended)

To improve readability, line breaks have been inserted.

ID=TO-PASS(Ext) ;12345

&SVv=01.01

&PA=0000;home ;99

&T1=11/05/05,12:19:51
&D1=0;0&D2=0;0&D3=0;0&D4=0;0&D5=0;0&D6=0;0&D7=0;0&D8=0;0
&A1=+00.00;mA;0&A2=+00.00;mA; 0&A3=+00.00;mA;0&A4=+00.00;mA;0
&A5=+00.00;mA;0&A6=+00.00;mA;0&A7=+00.00;mA;0&A8=+00.00;mA;0
&VS=+25.16;V(Uv);0

DO0000

&AO0=+0000;mA;+0400;mA

&US=Hello
&P0=101550.000,5217.9860N,00855.2699E,4.4,51.5,2,309.35,3.7,2.0,11
0505, 00

&G1=0.03;1;1;0;1;0;0;0;0

waco'

Manual
Version 2.0.0



WAGO-TO-PASS® 761 WAGO TO-PASS® Web 115
761-216 TO-PASS® Compact, 8 Al, Web, MODBUS

10.3.1.3 Value Script FW 2.33 (Counter Inputs)

The counter inputs have resulted in counter data, signal quality and an indicator
being added to the display for the value script ("SV=02.00") and to an update of
the MODBUS registers and analog outputs.

Example:

ID=GpsLongTest;50645

&SV=02.00

&PA=0000;home ;99

&HT=1

&T1=00/01/01,00:00:37
&D1=0;0&D2=0;0&D3=0;0&D4=0;0&D5=0;0&D6=0;0&D7=0;0&D8=0;0
&A1=+00.01;mA;0&A2=+03.70;mA;0&A3=+09.87;mA;0&A4=+09.89;mA;0
&A5=+09.90;mA;0&A6=+09.89;mA;0&A7=+09.88;mA;0&A8=+09.87;mA;0
&VS=+23.97;V(Uv);0

&DO0O=0000

&A0=+000.0;%;+04.00;mA

&C1=0;0;0

&C2=r;20F5800;0

&C3=r;0;0

&C4=0;0;0

&SQ=21

&US=Hello

&MA=00;00;0

&MV=0026;0000;002E;0064,0026;0000;0054,0064

&HT=1: (value always 1) the device time has not been set (&T]I entry is operating
hours information, started on 01.01.00 at 00:00:00), otherwise this entry is not
present.

&AO: The analog outputs are formatted with decimal places.
&Cx: Counter status[1];counter value[8];Alarm[1]

The variables for the counters are only transmitted when at least one input has
been configured as a counter.
The counter status can assume the statuses indicated by the transmitted SMS:

Table 52: Counter status

Status |Explanation

Digital input not configured as a counter.

Counter is active.

Counter is not active.

Counter overflow.

Counter has been reset.

Counter has been started.

O |lnw (S|l o

Counter value has been changed.
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The counter status shows the last change that has occurred since the last value

script transmission, or after a system start (independent of the SMS and logger
status).

The counter values are indicated as hexadecimal values (as are the MODBUS

values).

Alarms can have the following statuses:

Table 53: Alarm status

Status |Explanation

0 No alarm

1 First value reached/transgressed

2 Second value reached/transgressed

If both values are reached simultaneously, only status 2" is transmitted.
&SQ: Signal quality or modem connection (without formatting):

Table 54: Signal quality (from AT Reference Guide by Telit)

Value |Quality

0 (-113) dBm or less

1 (-111) dBm

2...30 [(-109)dBm ... (-53)dBm / 2 dBm per stage
31 (-51)dBm or greater

99 Unknown or cannot be measured

&MV: Transmission is performed only up to the last configured register (module
address not 0).

If registers were not previously parameterized (module address = 0), these will be
marked as "ZERO".

If errors occurred during register querying, these will be flagged with "ERRO".
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10.3.1.4 Example of Value Script FW 2.33 (Counter Inputs)

To improve readability, line breaks have been inserted.

ID=TO-PASS(Cnt) ;12345

&SV=02.00

&PA=0000;home ;99

&T1=11/05/05,12:19:51
&D1=0;0&D2=0;0&D3=0;0&D4=0;0&D5=0;0&D6=0;0&D7=0;0&D8=0;0
&A1=+00.00;mA;0&A2=+00.00;mA; 0&A3=+00.00;mA;0&A4=+00.00;mA;0
&A5=+00.00;mA;0&A6=+00.00;mA;0&A7=+00.00;mA;0&A8=+00.00;mA;0
&VS=+25.16;V(Uv);0

DO0000

&AO0=+00.00;mA;+04.00;mA

&C1=0;0;0

&C2=r;20F5800;0

&C3=r;0;0

&C4=0;0;0

&SQ=21

&US=Hello
&P0=101550.000,5217.9860N,00855.2699E,4.4,51.5,2,309.35,3.7,2.0,11
0505.00

&G1=0.03;1;1;0;1;0;0;0;0

&MA=00;02;0

&MV=0026 ;NULL ; 002E ;0064 ;0026 ; ERRO; 0054 ;0064
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10.3.2 Logger Script

Data transmission to the logger script is activated via cyclical transmission
repetitions (Web interval). Data packet information contains the logger's values
that have not been acknowledged yet.
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10.3.2.1 Logger Script Standard

In the standard format, 10 logger entries are transmitted in a packet. Each entry

consists of a compressed data set of 14 binary bytes, which are attached to the

hexadecimal character string of the variable. This way, two characters are

transmitted per byte.

Table 55: Data format for logger script FW 2.20 (standard)

Index |Variable |Contents Format

0 ID Identity Identity[8];Serial number[5]

1 PA Parameter Cycle time[4];Provider[5];Alarm counter[2]

2 TI Date, time YY/MM/DD,hh:mm:ss;

3 LO Logger data sets Log[280]
10.3.2.1.1 Binary Data Format for Data Set

Byte: 0 1 2 3 4 5 6

(Bit 76543210765432107654321076543210765432107654321076543210)
Cont. : PNNNNNNNSJJJJIMMMMDDDDDhhhhhmmmmmmssssssDIN. .. .. AIN1....
Byte: 7 8 9 10 11 12 13

(Bit 76543210765432107654321076543210765432107654321076543210)
Cont.: AIN2..._AIN3..._AIN4..__AINS..__AIN6..._AIN7..._AIN8S....

P: Pointer for the next data set to be saved
NNNNNNN: Event number

S: Data set already sent

YYYY: Year

DDDDD: Day

MMMM : Month

hhhhh: Hour

mmmmmm: Minute

ssssss: Second

DIN..... : Digital inputs

AINX....: Analog input channel x (x =1 ... 8)

Note

Alarm marker for the multiplex function
When the multiplex function is used, the alarm markers for D1 to D4 are all '1' for
a multiplex alarm.

Reception must be acknowledged with "Values stored"” (refer to HTTP Response).
The data sets must be decompressed at the Web portal.

The data sets with the bits set P=1 or S=1 are invalid and must be deleted.

The data sets at the Web portal must be sorted by date/time.
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10.3.2.1.2 Example for Logger Script Standard

To improve readability, line breaks have been inserted.

ID=TO-PASS ;12345
&PA=0005;home ;99
&T1=11/05/05,14:36:11

&LO0=
092D4AD100000000000000000000
562D4AD123000000000000000000
3F2D4AD12A000000000000000000
562D4AD137000000000000000000
562D4AD159000000000000000000
562D4AD164000000000000000000
3F2D4AD169000000000000000000
562D4AD19A000000000000000000
3F2D4AD1A9000000000000000000
3F2D4AD1E8000000000000000000
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10.3.2.2 Logger Script Extension

The logger script has been updated due to extended functionalities. The “02.00”
version designation has been assigned due to major modifications.

Table 56: Data format for logger script FW 2.31 (extended)

Index |Variable | Contents Format

0 ID Identity Identity[8];Serial number[5]

1 LV Logger script version Version number[5] (currently “02.00”)

2 PA Parameter Cycle time[4];Provider[5];Alarm counter[2]
3 Tl Date, time YY/MM/DD,hh:mm:ss;

4 LIO1 1. 1/0 message [74] (see LIOx variable data format table)
5* LPD1 1. GPS message [81] (see LPDx variable data format table)
6 LIO2 2. 1/0 message [74] (see LIOx variable data format table)
7* LPD2 2. GPS message [81] (see LPDx variable data format table)
8 LI103 3. 1/0 message [74] (see LIOx variable data format table)
9* LPD3 3. GPS message [81] (see LPDx variable data format table)
10 LIO4 4. 1/0 message [74] (see LIOx variable data format table)
11* LPD4 4. GPS message [81] (see LPDx variable data format table)
12 LIO5 5. 1/0 message [74] (see LIOx variable data format table)
13* LPD5 5. GPS message [81] (see LPDx variable data format table)
14** | LI0O6 6. 1/0 message [74] (see LIOx variable data format table)
15** | LIO7 7. 1/0 message [74] (see LIOx variable data format table)
16** | LIO8 8. 1/0 message [74] (see LIOx variable data format table)
17** | LI09 9. 1/0 message [74] (see LIOx variable data format table)

* This variable is sent only if the GPS functionality is available in the TO-PASS®

telecontrol module.

** This variable is not sent if the GPS functionality is available in the TO-PASS®

telecontrol module.

The meaning of the LIOx and LPDx variables are given in the following tables:
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10.3.2.2.1 Data Format for LIOx Variable

Table 57: Data format for logger script FW 2.31 (extended), Variable LIOXx

Index |Contents Format

0 Message counter Message counter[4];
1 Event (cyclic logger) Event[2];

2 Event time stamp YY/MM/DD,hh:mm:ss;
3 Digital input image Image[2];

4 1. analog input Value > 3

5 2. analog input Value > 3

6 3. analog input Value > 3

7 4. analog input Value > 3

8 5. analog input Value > 3

9 6. analog input Value > 3

10 7. analog input Value > 3

11 8. analog input Value > 3

12 Supply voltage Value > 3

13 Digital output image Image[1];

14 1. analog output Value > 3

15 2. analog output Value > 3

10.3.2.2.2 Data Format for LPDx Variable

Table 58: Data format for logger script FW 2.31 (extended), Variable LPDx

Index | Contents Format

0 GPS position status Status 2

1 GPS UTC time stamp YY/MM/DD,hh:mm:ss;

2 Time stamp milliseconds Value > 3

3 Latitude Minutes[4];Rest[4];Direction[1];
4 Longitude Minutes[4];Rest[4];Direction[1];
5 Horizontal accuracy Accuracy[2];

6 Elevation Elevation[4];

7 Position accuracy Accuracy[1];

8 Direction Degree[4];

9 Speed in km/h Speed[4];

10 Speed in knots Speed[4];

11 Number of satellites Number[1];

12 Deviation Deviation[4]
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10.3.2.2.3 Example for Logger Script Extension

To improve readability, line breaks have been inserted.

ID=TO-PASS(Ext) ;12345

&LV=02.00

&PA=0005;home ;99

&T1=11/05/05,08:38:22

&L 101=0019;09;11/05/05,08:33:44;00;000;000;000;000;000;000;000;000
;C4A;0;000;000
&LPD1=10;08/01/01,06:33:35;274;0;0;N;0;0;W;00;0;0;0;0;0;0;0

&L 102=001A;3F;11/05/05,08:34:02;00;000;000;000;000;000;000;000;000
;BA2;0;000;000
&L.PD2=10;08/01/01,06:33:55;274;0;0;N;0;0;W;00;0;0;0;0;0;0;0
&L103=001B;56;11/05/05,08:34:26;00;000;000;000;000;000;000;000;000
;B89;0;000;000
&LPD3=C0;11/05/05,06:34:25;276;C41;2600;N;216;1621;E;0C;4D34;3;26A
F;21;11;7;0

&L 104=001C;56;11/05/05,08:34:36;00;000;000;000;000;000;000;000;000
;B83;0;000;000
&LPD4=C0;11/05/05,06:34:38;148;C41;2683;N;217;AD0;E;14;17E;3;F92;2
E;18;6;51

&L 105=001D;3F;11/05/05,08:35:01;00;000;000;000;000;000;000;000;000
;B78;0;000;000
&LPD5=C0;11/05/05,06:34:58;0;C41;268C;N;217;A93;E;F4;1BF;2;4AF2;12
;9:;0:1

Calculating values from LIOx:
The states of the digital inputs and outputs are mapped in a binary coded way:

Digital input image: 0x90 - ’1001.0000" - Inputs 1 and 4 are set.
Digital output image: 0x8 - 1000’ - Output 1 is set.

Analog values and supply voltage are mapped as 12-bit value in hexadecimal
format:

Analog values: 0x000 ... OXFDF - 0.00 mA ... 20.00 mA
Supply voltage: 0x000 ... OXFDF - 0.00V ... 35.20 V
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The calculations for longitudes/latitudes (see below) refer to the format as
transmitted in the NMEA data (ccmm.mmmm with cc = degree, mm.mmmm =
Angular minute). The cc.mm format is used to indicate the direction (also
according to NMEA definition).

Calculating values for LPDx:

Latitude: 5217.9860N - 52 * 60 + 17 = 3137 = 0xC41,
9860 = 0x2684 > C41;2684;N;

Longitude: 00855.2699E - 8 * 60 + 55 = 535 = 0x217,
2699 = OXA8B - 217;A8B;E;

Horizontal accuracy: 4.4 - 4.4 * 10 = 44 = 0x2C - 2C;

Altitude in m: 51.5 - 51.5 * 10 = 515 = 0x203 - 203;

Position accuracy: 2 2 2;

Direction: 309.35 - 309 x 60 + 35 = 18575 = 0x488F > 488F;

Speed in km/h: 3.7 > 3.7 * 10 = 37 = 0x25 > 25;

Speed in knots: 2.0 2 2.0 * 10 = 20 = 0x14 > 14;

Number of satellites: 6 > 6 = 0x6 > 6

Deviation in km: 0.03 - 0.03*100=3=0x3 > 3

Recalculating values from LPDx:

Latitude: C41;2683;N; - 0xC41 = 3137 - 3137 /60 =52 Rest 17,
0x2683 = 9859 - 5217.9859N

Longitude: 217;ADO0;E; - 0x217 =535 - 535/ 60 = 8 Rest 55,
OxADOQ = 2768 - 855.2768E

Horizontal accuracy: 14; - 0x14 =20-> 20/10=2.0

Altitude in m: 17E; > Ox17E =382 -> 382/ 10 =38.2

Position accuracy: 3; > 0x3 =3

Direction: F92; - 0xF92 = 3986 - 3986 / 60 = 66 Rest 26 > 66.26

Speed in km/h: 2E; > Ox2E =46 > 46/10=4.6

Speed in knots: 18; > 0x18 =24 > 24/10=2.4

Number of satellites: 6; > 0x6 = 6

Deviation in km: 51; - 0x51 =81 - 81 /100 =0.81
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10.3.2.3 Logger Script FW 2.33 (Counter Inputs)

The counter inputs have resulted in counter data and an indicator being added to
the display for non-set time (operating hours) to the logger script ("LV=02.01").

Example:

&HT=1

(same as for Value Script)
&LCD2=0;0;e;20F5800;d;0;0;0

10.3.2.3.1 Data Format of an LCDx Variable

Table 59: Data format, logger script extension, Variable LCDx

Index |Contents Format
0 Counter status 1st input Status 1
1 Counter value 1st input, hexadecimal |Value > 8
2 Counter status 2nd input Status 1
3 Counter value 2nd input, hexadecimal | Value > 8
4 Counter status 3rd input Status 1
5 Counter value 3rd input, hexadecimal |Value > 8
6 Counter status 4th input Status 1
7 Counter value 4th input, hexadecimal |Value > 8

The counter status can assume the statuses indicated by the transmitted SMS:

Table 60: Counter status

Status |Explanation

0 Digital input not configured as a counter.
e Counter is active.

d Counter is not active.

0 Counter overflow.

r Counter has been reset.

S Counter has been started.

C Counter value has been changed.

The counter status shows the last change that has occurred since the last logger
script transmission, or after a system start (independent of the SMS and value

status).

&HT=1: (value always 1) the device time has not been set (&T]I entry is operating
hours information, started on 01.01.00 at 00:00:00), otherwise this entry is not

present.
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Table 61: Number of data sets

Script Version GPS |Counter| &LO | &LIO | &LPD | &LCD
S

FW 2.20 - - 10

FW 2.31 ) - 9

FW 2.31 X - 5 5

FW 2.33 @) 0] 9

FW 2.33 X @) 5 5

FW 2.33 @) X 6 6

FW 2.33 X X 4 4 4

Example: navigation of level 3.

ID= TO-PASS(Cnt) ;12345
&LV=02.01
&PA=0010;home ;99
&T1=12/09/05,05:51:31

&L 101=0000;21;00/01/01,00:09:16;00;003;32E;7D5;7D9;7DA;7D8;7D6;7D5

;ADO;0;000;32D
&LCD1=0;0;r;54600;r;0;0;0

&L102=0001;11;00/01/01,00:09:52;00;CE3;32E;7D5;7D8;7DA;7D7;7D6;7D4

;ACE;0;D04;32D
&LCD2=0;0;€e;54600;d;0;0;0

&L103=0002;78;00/01/01,00:15:42;00;D01;32E;7D5;7D9;7DB;7D9;7D7;7D5

;ACF;0;D04 ;32D
&LCD3=0;0;0;545F9;d;0;0;0

&L 104=0003;69;00/01/01,00:16:38;00;D01;32E;7D5;7D9;7DA;7D8;7D6;7D5

;ACF;0;D04 ;32D
&LCD4=0;0;e;2A2F2;d;0;0;0

&L 105=0004;78;00/01/01,00:17:22;00;D01;32E;7D5;7D9;7DA;7D8;7D6;7D5

;ACF;0;D04;32D
&LCD5=0;0;0;48C79;d;0;0;0

&L106=0005;71;00/01/01,00:17:22;00;D01;32E;7D5;7D9;7DA;7D8;7D6;7D5

;ACF;0;D04 ;32D
&LCD6=0;0;0;48C79;d;0;0;0
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10.3.2.4 Time Request Script FW 2.33

If time adjustment is to take place via the Internet, a time request script is
transmitted on system start in order to adjust the time when a reply is received.
This script does not include any process data.

Example:

ID= TO-PASS(Cnt) ;12345 &TV=01.00
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10.4 HTTP Response

The response to the request contains a string and, optionally, the time of the Web
portal.

The Web portal time adjusts the time of the WAGO TO-PASS® telecontrol
module.

The data string must contain the following text:
“Values stored” or “Values stored:YY/MM/DD,hh:mm:ss”.

Date and time are optional and are required only if the time of the WAGO TO-
PASS® telecontrol module is to be set via the Web portal.

The Web portal can also report that the data has not been accepted, or that the
indicated script version is not supported:

"Values not stored"

Starting from Firmware Version 02.33.08, setpoint settings for digital and analog
outputs and for changing the counters can be transmitted as replies.

Table 62: Setpoint settings

Variable |Contents Format

?A01 1. analog output Normalized value (decimal
&AOn  |n. analog output (n: 2) places allowed)

&DOn n. digital output (n: 1 ... 4) 0 =not set, 1 = set

&CEn n. activate counter input (n: 1 ... 4) 0 = active, 1 = inactive
&CRn n. reset counter input (n: 1 ... 4) 1 = reset

&CVn n. change counter value (n: 1 ... 4) Value[8], hexadecimal

Only those outputs that are available and that are configured for the Web outputs
are evaluated. A check should be made for inbound data sets to determine which
inputs have been configured as counters. There is no reply indicating whether the
counter setting and switching of the outputs has been successful. The subsequent
data transfer would have to be evaluated to determine this (e.g., by a feedback
loop to an input with additional alarm generation).
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10.4.1

Example of HTTP Response

The HTTP response consists of both header and data string, which are separated
by an empty line (<CR><LF> = Carriage Return + Line Feed).

HTTP/1.1 200 OK<CR><LF>

Date: Fri, 19 Sep 2008 11:22:23 GMT<CR><LF>
Server: Apache <CR><LF>

Content length: 31<CR><LF>

Keep alive: timeout=15, max=100<CR><LF>
Connection: Keep-Alive<CR><LF>

Content type: text/html<CR><LF>
<CR><LF>[.--11

Values stored:08/09/19,13:22:23

The header depends on both installation and Web portal settings and may deviate
from the illustration shown above.

Beispiel fir Sollwertvorgaben (Zeilenumbriche zur besseren Lesbarkeit):

Values stored:12/09/05,12:31:57

?A01=12.138&A02=12 .528&A03=08&A04=0&A05=0&A06=0&A07=0&A08=0
&D01=0&D02=0&D03=1&D04=1&D05=0&D06=0&D07=0&D08=0
&CV2=000001F4

&CR2=1

&CE2=1

&CV3=0000C350

&CE3=0
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